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1 Introduction

1.1 About the User Manual

This user manual provides step-by-step instructions on how to install the
drivers and the software needed on a host system or configuration PC
running under a Windows® operating system in order to configure and
diagnose Hilscher comX and netJACK communication modules or to
update the firmware of the modules.

This manual describes the installation of:
e the cifX Device Driver
e the SYCON.net configuration software

¢ the netX Configuration Tool (configuration tool for slave devices only)

e the USB Drivers

for the operating systems:

Windows XP
Windows 7
Windows 8
Windows 10

_) Note: Instructions for installation under Windows 7 are also applicable for
installation under Windows VISTA.

The drivers and the configuration software are provided on the

Communication Solutions DVD.

1.11 List of Revisions

Index |Date Chapter Revision
1 2013-10-16 all created
2 2017-04-03 all Software versions updated.

Instructions for installation under Windows 10
added.

Legal Notes updated.

Table 1: List of Revisions
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1.1.2 Conventions in this Document

Notes, operation instructions and results of operation steps are marked as
follows:

Notes

Important: <important note>

Note:

<note>

A <note, where to find further information>

Operation Instructions
1. <operation step>

» <instruction>

» <instruction>

2. <operation step>
> <instruction>
» <instruction>

Results

R <result>

1.1.3 Reference on Driver and Software Versions

This user manual refers to the following driver and software versions:

Name Version File name Path on Communication Solution DVD
SYCON.net 1.0400.x.x | SYCONnet netX setup.exe Software\SYCON.net

netX Configuration |1.0900.x.x | netXConfigurationUtility | Software\Slave Configuration Tool
Tool _Setup.exe

cifX Device Driver | 1.3.x.x cifX Device Driver Driver and Toolkit\Device Driver

Setup.exe

(NXDRV-WIN)\Instal lation

USB diagnostic
driver

setup.exe

Driver and Toolkit\USB Diagnostic
Driver

Table 2: Reference on Drivers and Software

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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1.2 Legal Notes

Copyright
© Hilscher Gesellschaft fur Systemautomation mbH
All rights reserved.

The images, photographs and texts in the accompanying materials (in the
form of a user's manual, operator's manual, Statement of Work document
and all other document types, support texts, documentation, etc.) are
protected by German and international copyright and by international trade
and protective provisions. Without the prior written consent, you do not
have permission to duplicate them either in full or in part using technical or
mechanical methods (print, photocopy or any other method), to edit them
using electronic systems or to transfer them. You are not permitted to make
changes to copyright notices, markings, trademarks or ownership
declarations. lllustrations are provided without taking the patent situation
into account. Any company names and product designations provided in
this document may be brands or trademarks by the corresponding owner
and may be protected under trademark, brand or patent law. Any form of
further use shall require the express consent from the relevant owner of the
rights.

Important notes

Utmost care was/is given in the preparation of the documentation at hand
consisting of a user's manual, operating manual and any other document
type and accompanying texts. However, errors cannot be ruled out.
Therefore, we cannot assume any guarantee or legal responsibility for
erroneous information or liability of any kind. You are hereby made aware
that descriptions found in the user's manual, the accompanying texts and
the documentation neither represent a guarantee nor any indication on
proper use as stipulated in the agreement or a promised attribute. It cannot
be ruled out that the user's manual, the accompanying texts and the
documentation do not completely match the described attributes, standards
or any other data for the delivered product. A warranty or guarantee with
respect to the correctness or accuracy of the information is not assumed.

We reserve the right to modify our products and the specifications for such
as well as the corresponding documentation in the form of a user's manual,
operating manual and/or any other document types and accompanying
texts at any time and without notice without being required to notify of said
moadification. Changes shall be taken into account in future manuals and do
not represent an obligation of any kind, in particular there shall be no right
to have delivered documents revised. The manual delivered with the
product shall apply.

Under no circumstances shall Hilscher Gesellschaft flir Systemautomation
mbH be liable for direct, indirect, ancillary or subsequent damage, or for
any loss of income, which may arise after use of the information contained
herein.

Liability disclaimer

The hardware and/or software was created and tested by Hilscher
Gesellschaft fur Systemautomation mbH with utmost care and is made
available as is. No warranty can be assumed for the performance or
flawlessness of the hardware and/or software under all application
conditions and scenarios and the work results achieved by the user when
using the hardware and/or software. Liability for any damage that may have

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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occurred as a result of using the hardware and/or software or the
corresponding documents shall be limited to an event involving willful intent
or a grossly negligent violation of a fundamental contractual obligation.
However, the right to assert damages due to a violation of a fundamental
contractual obligation shall be limited to contract-typical foreseeable
damage.

It is hereby expressly agreed upon in particular that any use or utilization of
the hardware and/or software in connection with

Flight control systems in aviation and aerospace;
Nuclear fusion processes in nuclear power plants;
Medical devices used for life support and

Vehicle control systems used in passenger transport

shall be excluded. Use of the hardware and/or software in any of the
following areas is strictly prohibited:

¢ For military purposes or in weaponry;

e For designing, engineering, maintaining or operating nuclear systems;
¢ In flight safety systems, aviation and flight telecommunications systems;
¢ In life-support systems;

e In systems in which any malfunction in the hardware and/or software
may result in physical injuries or fatalities.

You are hereby made aware that the hardware and/or software was not
created for use in hazardous environments, which require fail-safe control
mechanisms. Use of the hardware and/or software in this kind of
environment shall be at your own risk; any liability for damage or loss due
to impermissible use shall be excluded.

Warranty

Hilscher Gesellschaft fir Systemautomation mbH hereby guarantees that
the software shall run without errors in accordance with the requirements
listed in the specifications and that there were no defects on the date of
acceptance. The warranty period shall be 12 months commencing as of the
date of acceptance or purchase (with express declaration or implied, by
customer's conclusive behavior, e.g. putting into operation permanently).

The warranty obligation for equipment (hardware) we produce is 36
months, calculated as of the date of delivery ex works. The aforementioned
provisions shall not apply if longer warranty periods are mandatory by law
pursuant to Section 438 (1.2) BGB, Section 479 (1) BGB and Section 634a
(1) BGB [Burgerliches Gesetzbuch; German Civil Code] If, despite of all
due care taken, the delivered product should have a defect, which already
existed at the time of the transfer of risk, it shall be at our discretion to
either repair the product or to deliver a replacement product, subject to
timely notification of defect.

The warranty obligation shall not apply if the notification of defect is not
asserted promptly, if the purchaser or third party has tampered with the
products, if the defect is the result of natural wear, was caused by
unfavorable operating conditions or is due to violations against our
operating regulations or against rules of good electrical engineering
practice, or if our request to return the defective object is not promptly
complied with.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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Costs of support, maintenance, customization and product care

Please be advised that any subsequent improvement shall only be free of
charge if a defect is found. Any form of technical support, maintenance and
customization is not a warranty service, but instead shall be charged extra.

Additional guarantees

Although the hardware and software was developed and tested in-depth
with greatest care, Hilscher Gesellschaft fir Systemautomation mbH shall
not assume any guarantee for the suitability thereof for any purpose that
was not confirmed in writing. No guarantee can be granted whereby the
hardware and software satisfies your requirements, or the use of the
hardware and/or software is uninterruptable or the hardware and/or
software is fault-free.

It cannot be guaranteed that patents and/or ownership privileges have not
been infringed upon or violated or that the products are free from third-party
influence. No additional guarantees or promises shall be made as to
whether the product is market current, free from deficiency in title, or can be
integrated or is usable for specific purposes, unless such guarantees or
promises are required under existing law and cannot be restricted.

Confidentiality

The customer hereby expressly acknowledges that this document contains
trade secrets, information protected by copyright and other patent and
ownership privileges as well as any related rights of Hilscher Gesellschaft
fir Systemautomation mbH. The customer agrees to treat as confidential all
of the information made available to customer by Hilscher Gesellschaft fir
Systemautomation mbH and rights, which were disclosed by Hilscher
Gesellschaft fur Systemautomation mbH and that were made accessible as
well as the terms and conditions of this agreement itself.

The parties hereby agree to one another that the information that each
party receives from the other party respectively is and shall remain the
intellectual property of said other party, unless provided for otherwise in a
contractual agreement.

The customer must not allow any third party to become knowledgeable of
this expertise and shall only provide knowledge thereof to authorized users
as appropriate and necessary. Companies associated with the customer
shall not be deemed third parties. The customer must obligate authorized
users to confidentiality. The customer should only use the confidential
information in connection with the performances specified in this
agreement.

The customer must not use this confidential information to his own
advantage or for his own purposes or rather to the advantage or for the
purpose of a third party, nor must it be used for commercial purposes and
this confidential information must only be used to the extent provided for in
this agreement or otherwise to the extent as expressly authorized by the
disclosing party in written form. The customer has the right, subject to the
obligation to confidentiality, to disclose the terms and conditions of this
agreement directly to his legal and financial consultants as would be
required for the customer's normal business operation.

Export provisions

The delivered product (including technical data) is subject to the legal
export and/or import laws as well as any associated regulations of various
countries, especially such laws applicable in Germany and in the United
States. The products / hardware / software must not be exported into such

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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countries for which export is prohibited under US American export control
laws and its supplementary provisions. You hereby agree to strictly follow
the regulations and to yourself be responsible for observing them. You are
hereby made aware that you may be required to obtain governmental
approval to export, reexport or import the product.

1.2.1 Registered Trademarks

Windows® XP, Windows® Vista, Windows® 7, Windows® 8 and
Windows® 10 are registered trademarks of Microsoft Corporation.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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2 cifX Device Driver
2.1 Overview

If the host system of your communication module runs under a Windows
operating system or if you want to connect your module via PCI Carrier
Board (comX) or via Evaluation Board (netJACK) to a Windows PC for
configuration, diagnosis or firmware download with SYCON.net or netX
Configuration Tool, you need to install the cifX Device Driver.

The cifX Device Driver is delivered on the Communication Solutions DVD.
You can start an installation program for the driver (the cifX Device Driver
Setup) in the menu of the start screen of the DVD. Instructions for this are
provided on the following pages. You can also start the installation program
by double-clicking the cifX Device Driver Setup.exe file in the Driver and
Toolkit\Device Driver (NXDRV-WIN)\Installation directory of
the Communication Solutions DVD.

The installation program contains all components needed for the installation
of the driver under Windows XP, Windows Vista, Windows 7, Windows 8
and Windows 10. It detects whether the 32 bit or the 64 bit driver needs to
be installed.

Please note the following:

e You need administrator rights for installing or uninstalling the cifX Device
Driver on your operating system.

e Always use the installation program, if possible, to install the cifX Device
Driver, as described on the following pages.

¢ If an older version of the cifX Device Driver is installed on your system,
uninstall it first before you install the new version.

¢ Install the cifX Device Driver before you connect your communication
module to your host system or PC (“software first” principle).

o After installing the cifX Device Driver and connecting your
communication module, check in the Device Manager of Windows if the
driver has been correctly installed and if Windows recognizes the
connected communication module.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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2.2 Installing cifX Device Driver

2.2.1 Installing cifX Device Driver under Windows XP
2211 Installing cifX Device Driver by Installation Program

1. Start the cifX Device Driver installation program.

» Double-click the Communication-Solutions.exe file in the root
directory of the un-zipped Communication SolutionsDVD.

 The Flash start screen Communication Solutions is displayed:

Communication Solutions

Installation Guide
Install SYCOM.net Configuration Software
Documentation
Drivers, Software and Tools
Install cif / netJACK Device Driver
Install USB Diagnosis Driver
Install USE SPM Driver
Start netHOST for Remote access
Install Slave Configuration Software
Drriver-Toolkit for Programmers

Auxiliary Tools

4o\ ANcoce CCoLink Devicei et ethercaT= Etheri‘et/IP &
L R 1 o . i i .—‘ =
sowenk Woanus SE0G° _gosEr” Sercos hilscher

COMMUNICATION

Figure 1: Start Screen Communication Solutions — Installing cifX Device Driver

> In the menu, select Drivers, Software and Tools > Install
cifX/netJACK Device Driver.

clicking the cifX Device Driver Setup.exe file in the Driver and
Toolkit\Device Driver (NXDRV-WIN)\Installation folder of
the Communication Solutions DVD.

Note: Alternatively, you can also start the installation program by double-

Software Installation comX and netJACK | Installing Drivers and Configuration Software
DOC130405UMO02EN | Revision 2 | English | 2017-04 | Released | Public © Hilscher 2013 - 2017



cifX Device Driver 12/147

> The cifX Device Driver Setup is started and the License Agreement
window opens:

. cif¥% Device Driver (x86) 1.2.3.x Setup Z||:|fg|

Please read the cif Device Driver (x86) 1.2.x.x.
License Agreement

HILSCHER SOFTWARE LICEMSE
AGREEMEMT

|

This document s a Tlegal agreement
between you, the Ticense, and
Hilscher Gesellschaft fir
Systemautomation mhH,
{"Hilscher"). Please read this
agreement carefully before you
install the software. By
installing or otherwise using the
software, you accept the terms of
this agresment. If you do not
agree to the terms of this
agreement, then do not install or
Lse thelSngwarge return it to us

|

[¥1 accept the kerms in the License Agreement!

Back [ Install ] [ Cancel

Figure 2: cifX Device Driver Setup — License Agreement

2. Start installation.

» Select | accept the terms in the license agreement.
» Click Install.

2 The cifX Device Driver installation is started:

& cif¥ Device Driver (x86) 1.2.x.x Setup

- - _ E / Rery
Installing cifX Device Driver (x86) 1.2.x.% “p m |
L )

Please wait while the Setup Wizard installs cify Device Driver (x86) 1.2 .x.x.

Skatus:

Back Mext | Cancel |

Figure 3: Installing cifX Device Driver

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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2 After installation, the Completed the cifX Device Driver Setup Wizard
window appears:

. cif¥% Device Driver (x86) 1.2.3.x Setup E||§|rg|

== Completed the cifX Device Driver (x86)
. 1.2 % Setup Wizard

Click the Finish button to exit the Setup ‘Wizard,

If ywou upgraded from a previous wersion, you may need to
restart wour computer to finish the Installation.

Figure 4: cifX Device Driver — Installation Completed

> Click Finish.

_} Note: Under Windows XP, the driver installation process is not yet
finished after having executed the cifX Device Driver Setup Wizard.

The installation process has to be completed in the Found New
Hardware Wizard, which automatically opens when you reboot
Windows XP after having installed the communication module in your host
system, respectively after having connected the module to your PC via
PCI Carrier Board (comX) or via Evaluation Board (netJACK) to your
Windows PC for the first time.

3. Install communication module in host system/PC.

Important: When installing the hardware, observe all safety messages in
the user manual.

» Shut down Windows XP and disconnect your host system or PC from
the voltage supply.

» Install the communication module in your host system, respectively
connect the communication module to your PC according to the
instructions provided in the user manual.

See user manual

¢ * comX — Communication Modules for Real-Time-Ethernet and Fieldbus,
DOC100903UMXXEN

or

= netJACK Communication Module — Installation, Operation and
Hardware Description, DOC110504UMXXEN

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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4. Complete the installation in the Found New Hardware Wizard.
» Restart your host system/PC.
» The Found New Hardware Wizard starts:

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Windows will zearch for current and updated sofbware by
locking on your computer, on the hardware installation CD, or on
the Windows Update Web site [with your permizzion).

Read our privacy policy

Can Windows connect to Windows Update to search for
software?

) Yes, thiz time only

Click Mext to continue.

I Mest » ][ Cancel ]

Figure 5: Found New Hardware Wizard — cifX Device Driver (1)

» Answer the question Can Windows connect to Windows Update...?,
by selecting the No, not this time option.

» Click Next.
2 The window with the installation options appears:

Found Mew Hardware Wizard

Thiz wizard helps vou install zoftware far:

netl&CK 100 PCI/PCle Device

Z:') If your hardware came with an installation CD
“4&2 or Hoppy dizk, insert it now.

YWhat da pou wart the wizard ta da?

(&) install the softweare automatically [Fecommended}

() Inatall fram & list or specific location [Adwvanced)

Click Mext to continue.

[ < Back " Mest > ][ Cancel l

Figure 6: Found New Hardware Wizard — cifX Device Driver (2)

» If you have already executed the installation program for the cifX Device
Driver (as recommended), you can ignore the wizard’s request to insert
a CD or floppy disk. Answer the What do you want the wizard to do?
guestion by selecting the Install the software automatically option.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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> Click Next.

2 Windows copies the driver files to the Windows directories.

Found New Hardware Wizard
Please wait while the wizard installs the software. .. .

[ZZ =) netl4CK 100 PCI/PCle Device

WwidfColnstallerd 009, dl
To E:NWIND WS haystem32

Figure 7: Found New Hardware Wizard — cifX Device Driver (3)

2 The Completing the Found New Hardware Wizard window appears:

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard haz finizhed inztaling the softveare for:

netlACK, 100 PCI/PCle Device

Click Finizh to close the wizard.

Figure 8: Found New Hardware Wizard — cifX Device Driver (4)

> Click Finish.

 The installation of the cifX Device Driver is now complete.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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Checking Installation

After having installed the cifX Device Driver and having installed/connected
the communication module, you should check in the Windows Device
Manager if the driver has been correctly installed and if Windows

recognizes the communication module.

1. Open the Device Manager.

> In the Start menu of Windows, select Control Panel.

> The Control Panel opens:

B Control Panel

File Edit  Wiew

\_) Back -\_)

Favorites  Tools  Help

Lﬁ; pSearch H__ Falders v

Address [} Control Panel

= Mame =~
ﬂ"" Control Panel b3 anternet Options
&Keyboard
[} Swikch bo Category Wiew ) Mause
@_Network Connections
LPhone and Mademn Options
See Also {‘hpower Cptions

2y Printers and Faxes

Q Regional and Language Options
Ia.Scanners and Cameras

[ 5cheduled Tasks

@ Security Center

Oscundmaz audicese

'D; Sounds and Audio Devices

4 speech
L System
aTaskbar and Stark Menu
ﬁUser Accounts

a Windows CardSpace

%‘I windows Firewall

=255 Wireless Nebwork Setup Wizard

& Windows Update
Q) Help and Suppart

V|GD
~

Configure your Internet displa. ..
Customize vour kevboard setti.,,
Customize your mouse setking. ..
Connects ko other computers, ...
Configure your telephone diali. ..
Configure energy-saving setti. ..
Shows installed prinkers and Fa. ..
Customize settings for the disp...
&dd, remove, and configure sc...
Schedule computer kasks to ru...
View wour current secarity skat,..
Soundra AudicESP settings
Change the sound scheme For ..,
Change settings for text-to-sp..,
See information about your ca...

Camments

Customize the Start Menu and ...
Change user account settings ...
Yerwalten Sie die zum Anmelde. ..
Configure the Wwindows Firewall

Set up or add to a wireless net. .,

W

Figure 9: Control Panel

» Inthe Control Panel, double-click System.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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» The System Properties sheet opens:

System Properties

Syztem Restore Automati Remote
General Carnputer Mame Advanced

Device Manager

The Device Manager lists all the hardware devices installed
= on vaur computer. Use the Device Manager to change the
properties of any device.

Device Manager

Dirivers

Diriver Signing lets you make sure that installed drivers are
compatible with Windows, “Windows Update letz vou zet up
how windows connects to windows Update for drivers.

[ Diriver Signing l [ Windows Update

Hardware Profiles

Hardware profiles provide a way for you to zet up and store
different hardware configurations.

[ Hardware Prafiles l

I Ok H Cancel ]

Figure 10: System Properties

» Inthe System Properties sheet, select Hardware tab.
» Inthe Hardware tab, click Device Manager.
 The Device Manager starts:

£ Device Manager El@lrs__q

File  Action Wiew Help

M HES 2E A& =518

==} TMO1EN
-1 B8 cifX Communication Interface
-0 net JACK 100 PCIPCIe Device
-_-é Camputer
g Disk drives
§ Display adapkers
by DVDYCD-ROM drives
= Floppy disk controllers
+ 3 Floppy disk drives
+-[38 Hurman Interface Devices
+-i=%) IDE ATAJATAPI controllers
+-im Kevboards
+- ") Mice and other pointing devices
+- 5 Monitars
+- EH8 Network adapters
+- 5 Parts (COM &.LPT)
+ ﬂ Processors
+- 8, Sound, video and game contrallers

+ Syskem devices
+ Universal Serial Bus controllers

+

e[ [] [

Figure 11: Display of Communication Module in Device Manager

Software Installation comX and netJACK | Installing Drivers and Configuration Software
DOC130405UMO02EN | Revision 2 | English | 2017-04 | Released | Public © Hilscher 2013 - 2017



cifX Device Driver 18/147

2. Check if the communication module is recognized.

» In the Device Manager, click on the plus symbol in front of the
cifX Communication Interface entry.

2 A netJACK NJ 100EN-RE communication module for instance, which is
connected via NJEB-E Evaluation Board to the PCI Express interface of
the PC, will be displayed as netJACK 100 PCI/PCle Device.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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2.2.2 Installing cifX Device Driver under Windows 7
2221 Installing cifX Device Driver by Installation Program

1. Start the cifX Device Driver installation program.

> Double-click the Communication-Solutions.exe file in the root
directory of the un-zipped Communication SolutionsDVD.

2 The Flash start screen Communication Solutions is displayed:

Communication Solutions

Installation Guide

Install SYCOM.net Configuration Software

Documentation

Drivers, Software and Tools
Install cif} / netJACK Device Driver
Install USB Diagnosis Driver
Install USB SPM Driver
Start netHOST for Remote access
Install Slave Configuration Software
Driver-Toolkit for Programmers
Auxiliary Tools

@ ¢ANooer ((CrLink Deviceitet EthercAT Etheritet/IP &
N— o " ; Sehe
POWERLINK WMocbus ZEEEES garcoe !!.In!:f(ﬁnéf .N

. CORMMUNICATION

Figure 12: Start Screen Communication Solutions — Installing cifX Device Driver

> In the menu, select Drivers, Software and Tools > Install
cifX/netJACK Device Driver.

Note: Alternatively, you can also start the installation program by double-
clicking the cifX Device Driver Setup.exe file in the Driver and
Toolkit\Device Driver (NXDRV-WIN)\Installation folder of
the Communication Solutions DVD.

You can reduce the number of Windows security questions by right-
clicking on the cifX Device Driver Setup.exe file and choosing Run as
administrator from the context menu.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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> The cifX Device Driver Setup is started and the License Agreement
window opens:

-
if% Device Dri 64) 1.2.x.x Set a =
ﬁ ci evice Dinver (x64) . Setup —

Please read the cifX Device Driver (x64) 1.2.%.x
License Agreement

HILSCHER SOFTWARE LICENSE -
AGREEMENT I:I

This document is a legal Agreement
between wou, the Ticense, and
Hilscher Gesellschaft fur
Systemautomation mbH,
("Hilscher"). Please read this
Agreement carefully before you
install the software. By
installing or otherwise using the
software, you accept the terms of
this Agreement. If you do not
agree to the terms of this
Agreement, then do not install or
use the software, return it to us =

[¥]T accent the terms in the License Agreement:

e W
i Back [ @Lﬂsmll ] [ Cancel

I

Figure 13: cifX Device Driver Setup — License Agreement

2. Start installation.

» Select | accept the terms in the license agreement.
» Click Install.

> The cifX Device Driver is started:

[ cif¥ Device Driver (x64) 1.2.3.x Setu

A
Installing cifX Device Driver (x64) 1.2.%.x

Please wait while the Setup Wizard installs ¢f¥ Device Driver (x64) 1.2.x.x.

Status:

Figure 14: Installing cifX Device Driver
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2 After installation, the Completed the cifX Device Driver Setup Wizard
window appears:

B acomiconr i 255 =
2

“'.

Completed the cifX Device Driver (x64)
1.2.%x.x Setup Wizard

Click the Finish button to exit the Setup Wizard.

If you upgraded from & previous version, you may need to
restart your computer to finish the Installation,

Figure 15: cifX Device Driver — Installation Completed

> Click Finish.

2 You can now proceed to connect your communication module to the
host system/PC.

Note: Under Windows 7, the driver installation process is practically
finished after having executed the installation program.

When you reboot Windows 7 after having installed the communication
module hardware in your host system, respectively after having connected
the module to your PC via PCI Carrier Board (comX) or via Evaluation
Board (netJACK) for the first time, the Installing device driver software
message appears in the Windows task bar. Windows then copies the
driver files to the appropriate Windows directories. This is an automated
process, you do not need to take any action in this. Finally, the Device
driver software installed successfully message appears in the task bar.

3. Install communication module in host system/PC.

Important: When installing the hardware, observe all safety messages in
the user manual.

» Shut down Windows 7 and disconnect your host system or PC from the
voltage supply.

» Install the communication module in your host system, respectively
connect the communication module to your PC according to the
instructions provided in the user manual.

See user manual

Y * comX — Communication Modules for Real-Time-Ethernet and Fieldbus,

DOC100903UMxXEN, respectively

= netJACK Communication Module — Installation, Operation and
Hardware Description, DOC110504UMxXEN
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Checking Installation

After having installed the cifX Device Driver and having installed/connected
the communication module, you should check in the Windows Device
Manager if the driver has been correctly installed and if Windows
recognizes the communication module.

1. Open the Device Manager.
» In the Start menu of Windows, select Control Panel.
> The Control Panel opens:

- | 3y | | |Ss:f:-" Centrol Panel o [

O@v@ » Control Panel »

Adjust your computer’s settings

View by: Category =

System and Security
Review your computer's status
Back up your computer

Find and fix problems

User Accounts
'5' Change account type

Appearance and

Network and Internet Personalization

View network status and tasks
Cheoose homegreup and sharing
options

&

Hardware and Sound

Change the theme
Change desktop background
Adjust screen resolution

Clock, Language, and Region

© ¢ &K

%ﬂ View devices and printers Change keyboards or other input
Add a device methods
Change display language
E—% Programs
4 Uninstall a program i Ease of Access
L Get programs { Let Windows suggest settings

Optimize visual display

Figure 16: Adjust Your Computer’s Settings Window

> In the Control Panel, click Hardware and Sound.
» The Hardware and Sound window opens:

@Uv|gﬁ » Contrel Panel » Hardware and Sound »

- | g | | Search Control Panel

Control Panel Home § z .
/ Devices and Printers

‘#I"BI Add adevice | Addaprinter | Mouse "\“:;f' Device Manager

System and Security

Network and Internet AutoPlay

Change default settings for media or devices
Play CDs or other media automatically

# Hardware and Sound

Programs
Sound
Adjust system volume

User Accounts

Change system sounds | Manage audic devices

Appearance and
Perzonalization Power Options

Change power-saving settings
Require a password when the computer wakes

Change when the computer sleeps | Choose a power plan

Clock, Language, and Regicn Change what the power buttons do

Ease of Access

Display
Make text and other items larger or smaller
Connect to an external display

Adjust screen reselution
How to correct monitor flicker (refresh rate)

Figure 17: Hardware and Sound Window
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» In the Devices and Printers group of the Hardware and Sound
window, click Device Manager.

 The Device Manager starts:

=y Device Manager
File  Action

e | T E HE 8 @SS

View Help

oo s

4 = im0lwind?

Al_-'l" cif Communication Interface
{EF netlACK 100 PCLPCle Device
{8 Computer

+— Disk drives

> B Display adapters

> L} DVD/CD-ROM drives

b =4 Floppy disk drives

b =3 Floppy drive controllers

5’:3 Human Interface Devices

b g IDE ATA/ATAPI controllers

b G Keyboards

b <Pl Mice and other pointing devices
» .M Monitors

l_-'ll‘ MNetwork adapters

__@ Other devices

o Y Ports (COM & LPT)

D Processors

b % Sound, video and game controllers
----_'l,-' Systemn devices

- § Universal 5erial Bus controllers

Figure 18: Display of Communication Module in Device Manager

2. Check if the communication module is recognized.

» In the Device Manager,

click on the triangle

cifX Communication Interface entry.

2 A netJACK NJ 100EN-RE communication module for instance, which is
connected via NJEB-E Evaluation Board to the PCI Express interface of
the PC, will be displayed as netJACK 100 PCI/PCle Device.

in front of the
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2.2.3 Installing cifX Device Driver under Windows 8
2231 Installing cifX Device Driver by Installation Program

1. Start the cifX Device Driver installation program.

> Double-click the Communication-Solutions.exe file in the root
directory of the un-zipped Communication SolutionsDVD.

2 The Flash start screen Communication Solutions is displayed:

Communication Solutions

Installation Guide

Install SYCOM.net Configuration Software

Documentation

Drivers, Software and Tools
Install cif} / netJACK Device Driver
Install USB Diagnosis Driver
Install USB SPM Driver
Start netHOST for Remote access
Install Slave Configuration Software
Driver-Toolkit for Programmers
Auxiliary Tools

@ ¢ANooer ((CrLink Deviceitet EthercAT Etheritet/IP &
N— o " ; Sehe
POWERLINK WMocbus ZEEEES garcoe !!.In!:f(ﬁnéf .N

. CORMMUNICATION

Figure 19: Start Screen Communication Solutions — Installing cifX Device Driver

> In the menu, select Drivers, Software and Tools > Install
cifX/netJACK Device Driver.

Note: Alternatively, you can also start the installation program by double-
clicking the cifX Device Driver Setup.exe file in the Driver and
Toolkit\Device Driver (NXDRV-WIN)\Installation folder of
the Communication Solutions DVD.

You can reduce the number of Windows security questions by right-
clicking on the cifX Device Driver Setup.exe file and choosing Run as
administrator from the context menu.
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> The cifX Device Driver Setup is started and the License Agreement
window opens:

Please read the cifX Device Driver (x64) 1.2.1.0
License Agresment

HILSCHER SOFTWARE LICENSE
AGREEMENT

This document is a legal Agreement
between you, the Ticense, and
Hilscher Gesellschaft far
Systemautomat1on mbH,

'Hilscher"). pPlease read this
Agreement carefully before you
install the software. By
installing or otherwise using the
software, you accept the terms of
this agreement. If you do not
agree to the terms of this
agreement, then do not install or
use thelsoftwareﬁ return it to us

[w]T accept the terms in the License Agreement:

Install

Figure 20: cifX Device Driver Setup — License Agreement

2. Start installation.

» Select | accept the terms in the license agreement.
» Click Install.

R The cifX Device Driver installation is started:

Installing cifX Device Driver (x64) 1.2.1.0

Please wait while the Setup Wizard installs cif¥ Device Driver (x64) 1.2.1.0.

Figure 21: Installing cifX Device Driver
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2 After installation, the Completed the cifX Device Driver Setup Wizard
window appears:

i cifX Device Driver (x64) 1.2.x.x-Setup = =

Completed the cifX Device Driver (x64)
1.2.1.0 Setup Wizard

Click the Finish button to exit the Setup Wizard.

If you upgraded from a previous version, you may need to
restart your computer to finish the Installation.

(]
'S

Figure 22: cifX Device Driver — Installation Completed

> Click Finish.

2 You can now proceed to connect your communication module to the
host system/PC.

_} Note: Under Windows 8, the driver installation process is practically
finished after having executed the installation program.

When you reboot Windows 8 after having installed the communication
module hardware in your host system, respectively after having connected
the module to your PC via PCI Carrier Board (comX) or via Evaluation
Board (netJACK) for the first time, Windows copies the driver files to the
appropriate Windows directories. This is an automated process, you do
not need to take any action in this.

3. Install communication module in host system/PC.

Important: When installing the hardware, observe all safety messages in
the user manual.

» Shut down Windows 8 and disconnect your host system or PC from the
voltage supply.

» Install the communication module in your host system, respectively
connect the communication module to your PC according to the
instructions provided in the user manual.

See user manual

' = comX — Communication Modules for Real-Time-Ethernet and Fieldbus,
DOC100903UMxXEN, respectively

= netJACK Communication Module — Installation, Operation and
Hardware Description, DOC110504UMXXEN
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2.2.3.2 Checking Installation

After having installed the cifX Device Driver and having installed/connected
the communication module, you should check in the Windows Device
Manager if the driver has been correctly installed and if Windows
recognizes the communication module.

1. Open the Control Panel.
» In the Start screen of Windows 8, right-click on an empty space.
2 The All apps button appears in the lower part of the screen:

All apps

Figure 23: All Apps Button

» Click All apps.
2 A list featuring all available programs (Apps) appears:

Sound Recorder
T-Zip File Manager = Df Steps Recorder mv  Command Prompt
n, Office-Dokument 3 : Aic fice Sticky Notes [ Computer
= | offnen 2

ﬁ People i e Control Panel

Photos ’ itale Sign: Notepad++ 7 Default Programs.

Reader i i hediz File Explorer

SkyDrive g c 0 Calculator | | WordPad Help and Support
H

Sports = ffice Character Map ewe! Run
Store m M ft Offi Math Input Panel i Task Manager
Notepad L Magnifier B Wi Defender

Video . Mic e Paint Marrator

g Snipping Tool

Figure 24: List of Installed Apps in Windows 8

» Inthe Apps list, click Control Panel.
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2 Windows 8 changes into “desktop mode” and opens the Control Panel:

1 B+ Control Panel »

Adjust your computer’s settings

System and Security

Review your computer's status

Save backup copies of your files with File
History

Find and fix problems

Network and Internet
View network status and tasks
Cheoose hemegroup and sharing options

Hardware and Sound

|5r:arch Control Panel

v &

View by: Category *

User Accounts
@' Change account type

Appearance and Personalization
Change the theme

Change desktop background

Adjust screen reselution

Clock, Language, and Region
Add a language

Change input metheods

View devices and printers .
Change date, time, or number formats

Add a device

Ease of Access
Let Windows suggest settings
Optimize visual display

Programs
Uninstall a pregram
Get programs

2,
N,
@

Figure 25: Control Panel

2. Open Device Manager.
> In the Control Panel, click Hardware and Sound.
2 The Hardware and Sound window opens:

@ -~ b % » Control Panel » Hardware and Sound » v & Search Control Panel

Control Panel Home z .
Devices and Printers

Add a device | Advanced printer setup
Change Windows To Ge startup options

Mouse @Device Manager

System and Security

Metwork and Internet
Hardware and Sound

AutoPlay

Change default settings for media or devices | Play CDs or other media automatically

Programs
Sound
Adjust system volume

User Accounts

Change system sounds | Manage audic devices

Appearance and
Personalization Power Options

Change power-saving settings | Change what the power buttons do

Require a password when the computer wakes | Change when the computer sleeps

Choose a power plan

Clock, Language, and Region

Ease of Access

Display
Make text and other items larger or smaller
How to correct monitor flicker (refresh rate)

Adjust screen resolution

Location Settings
Change location settings

Figure 26: Hardware and Sound
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» Inthe Devices and Printers group, click Device Manager.
2 The Device Manager starts:

File Action View Help

= @ E Ha e BsS

a = im0lwind
[ 1M Computer

[ ¢y Disk drives

i By Display adapters
2 DVD/CD-ROM drives
L=,',‘ﬂ=| Floppy disk drives

[+

[+

[ ta Floppy drive controllers
> Eﬁ Hurnan Interface Devices
[»
[+
[+
[»

g |IDEATA/ATAPI controllers
= Keyboards
ﬂ Mice and other pointing devices
& Monitors
b &P Network adapters
i+ [f5 Other devices
& YZF Ports (COM &L LPT)
[» @ Print queues
3 R Processors
[ ﬁi Sound, video and game controllers
4 @ cif{ Communication Interface
¢ L[ net’ACK 100 PCI/PCle Device|

[» M System devices

[ i Universal Serial Bus controllers

Figure 27: Display of Communication Module in Device Manager

3. Check if the communication module is recognized.

» In the Device Manager, click on the triangle in front of the
cifX Communication Interface entry.

2 A netJACK NJ 100EN-RE communication module for instance, which is
connected via NJEB-E Evaluation Board to the PCI Express interface of
the PC, will be displayed as netJACK 100 PCI/PCle Device.
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2.2.4
2241

Installing cifX Device Driver under Windows 10
Installing cifX Device Driver by Installation Program

1. Start the cifX Device Driver installation program.

> Double-click the Communication-Solutions.exe file in the root
directory of the un-zipped Communication SolutionsDVD.

2 The Flash start screen Communication Solutions is displayed:

Communication Solutions

Installation Guide

Install SYCOM.net Configuration Software

Documentation

Drivers, Software and Tools
Install cif} / netJACK Device Driver
Install USB Diagnosis Driver
Install USB SPM Driver
Start netHOST for Remote access
Install Slave Configuration Software
Driver-Toolkit for Programmers
Auxiliary Tools

@ ¢ANooen (CC-Link Deviceitet EthercAT™ Etheritet/IP
POWERLINK  TiVocibus i%%%%? " serco

the sutomation bus

A
hilscha

COMPETENCE IN

. CORMMUNICATION

Figure 28: Start Screen Communication Solutions — Installing cifX Device Driver

> In the menu, select Drivers, Software and Tools >

cifX/netJACK Device Driver.

Install

Note: Alternatively, you can also start the installation program by double-

clicking the cifX Device Driver Setup.exe file in the Driver and

Toolkit\Device Driver (NXDRV-WIN)\Installation folder of

the Communication Solutions DVD.
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> The cifX Device Driver Setup is started and the License Agreement
window opens:

ﬁ cifX Device Driver (x64) " Setup — b4

Please read the cif¥ Device Driver (x64) 8 0 525
License Agreement

HILSCHER S0FTWARE LICEMSE -
AGREEMENT

This document is a legal Agreement
between you, the license, and
Hilscher Gesellschaft fir
Ssystemautomation mbH,

("Hilscher™). Please read this
agreement carefully before you
install the software. By
installing or otherwise using the
software, you accept the terms of
this Agreement. If you do not
agree to the terms of this
Agreement, then do not install or
use theISOf;wargf return it tous

| SEReT
GosmETiRDE

1 TENOE i
— [T accept the terms in the License Agreement:
Print Back Install Cancel

Figure 29: cifX Device Driver Setup — License Agreement

2. Start installation.

» Select | accept the terms in the license agreement.
» Click Install.

R The cifX Device Driver installation is started:

Lﬁ cif¥ Device Driver (x64) " Setup — *

Installing cifX Device Driver (x64) 1 1 4 \{ o

Please wait while the Setup Wizard installs cif Device Driver (x64) I

Status: Creating duplicate files
|

Figure 30: Installing cifX Device Driver
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2 After installation, the Completed the cifX Device Driver Setup Wizard
window appears:

ﬁ cif¥ Device Driver (x64) Setup - X

Completed the cifX Device Driver (x64)
| Setup Wizard

Click the Finish button to exit the Setup Wizard.

If you upgraded from a previous version, you may need to
restart your computer to finish the Installation.

Back Cancel

Figure 31: cifX Device Driver — Installation Completed

» Click Finish.
2 You can now proceed to connect your communication module to the
host system/PC.

_} Note: Under Windows 10, the driver installation process is practically
finished after having executed the installation program.

When you reboot Windows 10 after having installed the communication
module hardware in your host system, respectively after having connected
the module to your PC via PCI Carrier Board (comX) or via Evaluation
Board (netJACK) for the first time, Windows copies the driver files to the
appropriate Windows directories. This is an automated process, you do
not need to take any action in this.

3. Install communication module in host system/PC.

Important: When installing the hardware, observe all safety messages in
the user manual.

» Shut down Windows 10 and disconnect your host system or PC from
the voltage supply.

» Install the communication module in your host system, respectively
connect the communication module to your PC according to the
instructions provided in the user manual.

See user manual
¢ * comX — Communication Modules for Real-Time-Ethernet and Fieldbus,
DOC100903UMXXEN, respectively

= netJACK Communication Module — Installation, Operation and
Hardware Description, DOC110504UMXXEN
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2242 Checking Installation

After having installed the cifX Device Driver and having installed/connected
the communication module, you should check in the Windows Device
Manager if the driver has been correctly installed and if Windows
recognizes the communication module.

1. Open the Device Manager.

» Right-click on the Windows Start symbol, then choose Device
Manager entry:

Programs and Features
Power Options

Event Viewer

System

Device Manager
Network Connections
Disk Management
Computer Management
Command Prompt

Command Prompt (Admin)

Task Manager
Control Panel
File Explorer
Search

Run

Shut down or sign out

Desktop

Figure 32: Open Device Manager in Windows 10
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2 The Device Manager starts:

;.j.; Device Manager

Action  View Help

& @I EEIE EXE

v B IMOTWin10
v Ij cifX Communication Interface

7 net)ACK 100 PCI/PCle Device
3 Computer
- Disk drives
& Display adapters
a5 Floppy disk drives
«& Floppy drive controllers

@ Mice and other pointing devices
[ Monitors

I Network adapters

E? Other devices

§ Ports (COM & LPT)

A Print queues

] Processors

B Software devices

I Sound, video and game controllers
& Storage controllers

K3 System devices

i Universal Serial Bus controllers

Figure 33: Display of Communication Module in Device Manager

2. Check if the communication module is recognized.
In the Device Manager, click on the triangle

cifX Communication Interface entry.

in front of the

2 A netJACK NJ 100EN-RE communication module for instance, which is

connected via NJEB-E Evaluation Board to the PCI Express interface of
the PC, will be displayed as netJACK 100 PCI/PCle Device.
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2.3 Uninstalling cifX Device Driver
2.3.1 Uninstalling cifX Device Driver under Windows XP

If you want to uninstall the USB drivers under Windows XP, proceed as

follows:

> In the Start menu of Windows XP, select Control Panel.

> The Control Panel opens:

B Control Panel

File Edit ‘iew Favorites Tools  Help

.\_)Back -\_':J Lﬁ; pSearch H__ Falders v

Address & Control Panel

Mame =

ﬂ"" Control Panel # 6ACCBSSibi|itY Cpkions
SE ndd Hardware

[:} Swikch bo Category Wiew i emave Programs
L Adrministrative Tools
‘u Automatic Updates

See Also P ciF Setup

By ciF % Test

ﬁ wWindows Update )

“2Dake and Time
Q) Help and Support }Displav
EdFiash Player
|FFalder Options
ﬁFonts
B Game Controllers
‘ﬁIndexerstelIung
B trteltry ama oriver
9Internet Cptions
@Keyboard
) Maouse
t_‘,Network Connections
LPhone and Modem Options
3

h Install or remove pragrams an...

V|GD
~

Adjust wour computer settings ...
Installs and troubleshoots hat...

Camments

Configure administrative sektin. .
Set up windows to automatical. ..
Setup cif Boards and charnels
Test your cif¥ Boards and Cha...
Set the date, time, and time ...
Change the appearance of vo...
Manage Flash Plaver Settings
Customize the display of files a...
&dd, change, and manage fon...
&dd, remove, and configure g...
Microsoft Office Find Fast (tm). ..
Stewern Sie die Grafikhardwar..
Configure your Internet displa. ..
Customize your keyboard setti,.,
Customize your mouse setking. ..
Connects to other computers, ..
Configure vour telephone diali, ..

W

Figure 34: Control Panel

> Inthe Control Panel, double-click Add or Remove Programs entry.
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2 The Add or Remove Programs window opens:

¥ Add or Remove Programs

L5
Change ar

Remaove
Programs

%

Add Mew
Programs

Add/Femave

Shrindores
Zomponents

@

Set Pragram
Access and
Defaulks
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Figure 35: Add or Remove Programs

» Select cifX Device Driver entry.
» Click Remove.
2 A security question appears:

Add or Remove Programs

\2'.') Are you sure you want ko remove cif Device Driver (x86) 1,2.x.x from your computer?

[ s |[ bo ]

Figure 36: Acknowledge Uninstall

> Click Yes.

2 The cifX Device Driver is removed from your host system/PC.
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Uninstalling cifX Device Driver under Windows 7

For a complete removal of the cifX Device Driver under Windows 7, it is
recommended to delete the driver first in the Device Manager, and then to
uninstall the driver in the Uninstall or change a program window.

1. Open the Device Manager.
> In the Windows Start menu, select Control Panel.
2 The Control Panel opens:

=N R~

o | s | | |Search Control Panel Jol |

O@v@ v Contrel Panel »

Adjust your computer’s settings

@ ]

View by: Category ~

System and Security

Review your computer's status

User Accounts

'5' Change account type
Back up your computer )

Find and fix problems Appearance and

Personalization
Change the theme
Change desktop background

Network and Internet
View network status and tasks
Cheose homegroup and sharing

options

Hardware and Sound
View devices and printers

&

Adjust screen resclution

Clock, Language, and Region
Change keyboards or other input
methods

®@ & §¥&

Add a device
Change display language
E—% Programs
= § Uninstall a program | EaSE:-‘. of Access .
4 Get programs Let Windows suggest settings

Optimize visual display

Figure 37: Adjust Your Computer’s Settings Window

> Inthe Control Panel, click Hardware and Sound.
? The Hardware and Sound window opens:

@vaﬁ + Contrel Panel » Hardware and Sound » - | +y | | Search Control Panel ol |

Contrel Panel Home z .
Devices and Printers

1 .."
= g?I Add a device | Add a printer

4
=

Mouse 'E'Device Manager

System and Security
MNetwork and Internet
* Hardware and Sound

AutoPlay
Change default settings for media or devices
Play CDs or other media automatically

Sound

Adjust system volume

Programs

User Accounts

Change system sounds | Manage audic devices

Appearance and
Personalization Power Options

Change power-saving settings | Change what the power buttons do
Require a password when the computer wakes

Change when the computer sleeps | Cheoose a power plan

Clock, Language, and Regicn

Ease of Access

Display
Make text and other items larger or smaller
Connect to an external display

Adjust screen resclution
How to correct monitor flicker (refresh rate)

Figure 38: Hardware and Sound Window

» Inthe Devices and Printers group, click Device Manager.
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2 The Device Manager starts.

=1 Device Manager EI@

File Action View Help
e | HIE B3 W ERS

4= im0lwind?

AI_TII‘ cifX Communication Interface
. LIEF net)ACK 100 PCI/PCle Device

48 Computer Update Driver Software..,
by Disk drives Disable
> By Display adapters Uninstall
» ey DVD/CD-ROM drives
:s =4 Floppy disk drives Scan for hardware changes
» =3 Floppy drive controllers
; Properties

J.”E] Human Interface Devices

b g IDE ATA/ATAPI controllers
... Keyboards

b jﬂ Mice and other pointing devices
- W Monitors

b -EF Metwork adapters

> -|i5) Other devices

5 X7 Ports (COM & LPT)

b 2 Processors

b -4 Sound, video and game controllers
b M Systemn devices

b § Universal Serial Bus controllers

Scan for changed or new Plug ant

Figure 39: Display of Communication Module in Device Manager

2. Delete cifX Device Driver in the Device Manager.

» In the Device Manager, below the cifX Communication Interface
entry, right-click on the communication module (in this case it is
displayed as netJACK 100 PCI/PCle Device) and choose Properties
from the context menu.

 The Properties sheet opens.

net!ACK 100 PCI/PCle Device Properties ==

General | Driver | Details | Resources

.L-. netJACK 100 PCI/PCle Device
=

Device type: cif ¥ Communication Interface
Manufacturer: Hilscher GmbH
Location: PCl bus 2, device 0, function 0

Device status

[This device is working propery. -

[ ok || cance |

Figure 40: Properties of Communication Module in Device Manager
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» Choose Driver tab.
 The Driver tab opens.

netlACK 100 PCY/PCle Device Properties =]

| General | Driver |De°tai|5 | Resources

:. netJACK 100 PCI/PCle Device
=

Driver Provider: Hilscher GmbH
Driver Date: 22/02/2013
Driver Version: 12XX

Digital Signer: Hilscher Gesellschaft fuer Systemautomation
mbH

To view details about the driverfiles.
To update the driver software for this device.

Roll Back Driver ¥ the device fails after updating the driver, roll
e back to the previously installed driver.

Disables the selected device.
To uninstall the driver (Advanced).

| ok || cancel |

Figure 41: Driver of Communication Module in Device Manager

» Click Uninstall.
2 The Confirm Device Uninstall dialog opens:

Confirm Device Uninstall @

L-. netJACK 100 PCI/PCle Device
-

Waming: You are about to uninstall this device from your system.

[¥]Delete the driver software for this device |

[ ok || Ccancel

Figure 42: Delete Driver Software

» Select Delete the driver software for this device option.
> Click OK.
2> The cifX Device Driver is being deleted.
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3. Uninstall cifX Device Driver in the Uninstall or change a program
window.

> In the Start menu of Windows, select Control Panel.
? The Adjust your computer’s settings window opens:

= e =)
O@vr » Control Panel » - |¢, | | |55':':"‘ Control Panel g |
Adjust your computer’s settings View by: Category ~
g  System and Security User Accounts
L ’3 Review your computer's status r ) Change account type
Back up your computer }
Find and fix problems Appearance and
w,_ Network and Internet w Personalization
ul View network status and tasks Change the theme
- Choose homegroup and sharing options Change desktop background
Adjust screen resolution
. / Hardware and Sound .
%‘ View devices and printers Clock, Language, and_ Region
Add a device | Change keyboards or other input
/ methods
E—% Programs Change display language
b g!tinm” S 47 Ease of Access
programs \ ; .
I | Let Windows suggest settings
\—/ Optimize visual display
Figure 43: Adjust Your Computer’s Settings Window
» Inthe Programs group, click Uninstall a program.
2 The Uninstall or change a program window opens:
o la =)
@uvl <« Prog.. » Programs and Feat... - | 3 | | Search Programs and Features o |

Control Panel Home .
Uninstall or change a program

View installed updates To uninstall a program, select it from the list and then click

Turn Windows features on or Uninstall, Change, or Repair,
off

(=

Install a program from the Organize *  Uninstall  Repair = - @
netwiark -
Mame i

XOE

fam cifX Device Driver (x64) 1.2

m

Uninstall

‘K

i

Repair

Entries from other programs

1@ TN =
|

-

i | "

E Hilscher Gesellschaft fuer Systemautomation mbH

Figure 44: Uninstall or Change a Program Window

» Right-click on the cifX Device Driver entry and choose Uninstall from
the context menu.
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2 A confirmation request appears:

Programs and Features

! . Areyou sure you want to uninstall cifX Device Driver (x64) 1.2..x?
N

In the future, do not show me this dialeg box | Yes | [ Mo

Figure 45: Confirmation Dialog

> Click Yes.

 The cifX Device Driver is being uninstalled from your host system or
PC.
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2.3.3

Uninstalling cifX Device Driver under Windows 8

For a complete removal of the cifX Device Driver under Windows 8, it is
recommended to delete the driver first in the Device Manager, and then to
uninstall the driver in the Uninstall or change a program window.

1. Open the Control Panel.

» In the Start screen of Windows 8, right-click on an empty space.
2 The All apps button appears in the lower part of the screen:

All apps

Figure 46: All Apps Button

» Click All apps.

2 A list featuring all available programs (Apps) appears:

7-Zip File Manager = i ft Offi
. PowerPoint 2

2 @

®

{  Notepad++ Windows Journal

I

ws Media

.E.

SkyDrive Calculator | WordPad

Sports " cl Offic Character Map

o P

Store fal ore 0 Math Input Panel

Magnifier

Marrator

Figure 47: List of Installed Apps in Windows 8

» Inthe Apps list, click Control Panel.

& Command Prompt

g Computer
F- Control Panel
=

L 3

Default Programs

- File Explorer

—

@ Help and Support
H

!Ru\

g Task Manager

‘Windows Defender
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2 Windows 8 changes into “desktop mode” and opens the Control Panel:

4+ & + Control Panel »

Adjust your computer’s settings

System and Security

Review your computer's status

Save backup copies of your files with File
History

Find and fix problems

_ Network and Internet
View network status and tasks
Cheose hemegroup and sharing eptions

Hardware and Sound
View devices and printers
Add a device

Programs
Uninstall a program
Get programs

L & i
Figure 48: Control Panel

2. Open Device Manager.
>

|Search Control Panel

v o
View by: Category =

User Accounts
'@' Change account type

Appearance and Personalization
Change the theme

Change desktop background

Adjust screen resolution

Clock, Language, and Region
Add a language

Change input metheds

Change date, time, er number formats

Ease of Access
Let Windows suggest settings
Optimize visual display

In the Control Panel, click Hardware and Sound.

2 The Hardware and Sound window opens:

- 7t % + Control Panel » Hardware and Sound »

©

Search Control Panel

v ©

Control Panel Home z B
Devices and Printers

Add a device

=
-~

%

System and Security

MNetwork and Internet

Advanced printer setup
Change Windows Te Go startup options

Meouse @Deuice Manager

Hardware and Sound AutoPl ay

Programs
Sound
Adjust system velume

User Accounts

Appearance and
Personalization Power Options

Clock, Language, and Region Change power-saving settings

Ease of Access
Choose a power plan

Display
Make text and other items larger or smaller
How to correct menitor flicker (refresh rate)

a € QZ

Location Settings
Change location settings

Figure 49: Hardware and Sound

Change default settings for media or devices

Change system sounds

Require a password when the computer wakes

Play CDs or other media automatically

Manage audic devices

Change what the power buttons do
Change when the computer sleeps

Adjust screen reselution
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>

In the Devices and Printers group, click Device Manager.
2 The Device Manager starts.

File Action View Help

&= @ 5 Hml € @K

Figure 50: Display of Communication Module in Device Manager

2. Delete cifX Device Driver in the Device Manager.

>

2 The Device Properties sheet opens:

Figure 51: Properties of Communication Module in Device Manager
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I R Processors
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> (M System devices
[ E Universal Serial Bus controllers

In the Device Manager, below the cifX Communication Interface
entry, right-click on the communication module (in this case it is
displayed as netJACK 100 PCI/PCle Device) and choose Properties

from the context menu.

General | Driver | Details | Events I Resources

ih netJ4CK 100 PCI/PCle Device

m,
Device type: cif ¥ Communication Intefface
Manufacturer: Hilscher GmbH
Location: PCl bus 2, device 0, function 0

Device status

This device is working propery.

Software Installation comX and netJACK | Installing Drivers and Configuration Software

DOC130405UMO2EN | Revision 2 | English | 2017-04 | Released | Public

© Hilscher 2013 - 2017



cifX Device Driver 45/147

» Choose Driver tab.
> The Driver tab opens.

| General | Driver |Detai|5 | Events I Resources

‘h netJACK 100 PCI/PCle Device
_-:'

-

Driver Provider: Hilscher GmbH
Driver Date: 2/22/213
Driver Version: 1.21.0

Digital Signer: Hilscher Gesellschaft fuer Systemautomation
mbH

To view details about the driverfiles.

To update the driver software for this device.

- ¥ the device fails after updating the driver, roll
i back to the previously installed driver.

Disables the selected device.
To uninstall the driver (Advanced).

OK || Cancel

Figure 52: Driver of Communication Module in Device Manager

» Click Uninstall.
2 The Confirm Device Uninstall dialog opens:

h";_ netJACK 100 PCI/PCle Device
ca,

Waming: You are about to uninstall this device from your system.

[v]Delete the driver software for this device ;

Figure 53: Delete Driver Software

» Select Delete the driver software for this device option.
» Click OK.

2 The cifX Device Driver is being deleted.
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3. Uninstall cifX Device Driver in the Uninstall or change a Program
window.

» Open Control Panel.
? The Control Panel opens:

T @ + Control Panel » v O |Search Control Panel

Adjust your computer’s settings View by: Category ~

System and Security User Accounts

Review your computer's status @ Change account type
Save backup copies of your files with File

Histery Appearance and Personalization
Find and fix problems Change the theme

Network and Internet Change desktop background

Il View network status and tasks

Cheose hemegroup and sharing eptions Clock, Language, and Region
Hardware and Sound /’ﬂ Add s language
o

Adjust screen resclution

) . . Change input methods
View devices and printers .
Add 3 device Change date, time, er number formats

Ease of Access

Programs ] .
Let Windows suggest settings

Uninstall a program

Get programs Optimize visual display

Figure 54: Control Panel

» In the Programs group of the Control Panel, click Uninstall a
program.

2 The Programs and Features window opens:

~ 4 [ « Programs + Programs and Features v O Search Programs and Features 0

Control Panel Home .
Uninstall or change a program

View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or
B Turn Windows features on or Repair.
off

Install a program from the Organize - Repair

network
Name

[577-Zip 9.22beta

HAdobe Reader X (10.1.0) - Deutsch

[Fim cifX Device Driver (x64) 1.2.x.x

@Java 7 Update 7

E] Microsoft Office Standard Edition 2003
Q’ Motepad++

B SYCON.net for netx

[ System Requirements Lab for Intel

E Hilscher Gesellschaft fuer Systemautomation mbH

Figure 55: Uninstall or Change a Program Window
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» Select cifX Device Driver entry.
» Above the list, click Uninstall.
> A security question appears:

E Are you sure you want te uninstall cif¥ Device Driver (x64) 1.2.x.x7

[] Inthefuture, do not show me this dialog box

Figure 56: Acknowledge Uninstall

> Click Yes.

2 The cifX Device Driver is being uninstalled from your host system or
PC.
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2.3.4 Uninstalling cifX Device Driver under Windows 10

1. Open the Programs and Features dialog window.

» Right-click on the Windows Start symbol, then choose Programs and
Features entry:

Programs and Features

Power Options

Event Viewer

System

Device Manager
Metwork Connections
Disk Management
Computer Management
Command Prompt

Command Prompt (Admin}

Task Manager
Control Panel
File Explorer
Search

Run

Shut down or sign out

Desktop

Figure 57: Open program manager in Windows 10
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2 The Uninstall or change a program window opens:

[E Programs and Features — [m| X

1 [@ » Control Panel » Programs » Programs and Features v O Search Programs and Features 0

Control Panel Home .
Uninstall or change a program

View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair,

) Turn Windows features on or
off

Organize *  Uninstall  Repair SEE o
Install a program from the ~
network MName Publisher Installed On  Size Version

p— — i EE

B == - pm=n T m E——— T bl =

E-. cifX Device Driver (x64) 1.3.0.0 Hilscher Gesellschaft fuer Syste...  3/30/2017 T32MB 13.00

A an B el [ B ETIME AR

T L e e e E [—— = i

LD e e et = p— - [} -

i 1B o e LB - e m LilLE 1"

[ R S i (&5 55 1

Thyeme e [ &3 i

[0 e e BT T e e T g — g=—— [}

pre— LT LEE Fe T ] FE— - el 1.1 N -

[0 B " Wil & - i w L == . " B RS

[ —— S —T— [RET— - - il -

Hilscher Gesellschaft fuer Systemautoma... Product version: 1.3.0.0
B:' Size: 7.32 MB

Figure 58: Uninstall or change a program window

» Select cifX Device Driver entry.
> Above the list, click Uninstall.
2 A security question appears:

Programs and Features

| Are you sure you want to uninstall cifX Device Driver (x64)

[ Inthe future, do not show me this dialog box Yes

Figure 59: Acknowledge Uninstall

» Click Yes.
2 The cifX Device Driver is being uninstalled from your PC.
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3 USB Driver
3.1 Overview

If a USB interface has been implemented on the carrier board of the host
system of your communication module and if you want to use this USB
interface to configure or diagnose your module or to update its firmware
from a Windows PC, you need to install the USB drivers on your Windows
PC. If you are operating a netJACK communication module with an
Evaluation Board, and if you want to access its USB interface from a
Windows PC, you also need to install the USB driver on your Windows PC.

The USB drivers are delivered on the Communication Solutions DVD.
You can start an installation program for the USB drivers in the menu of the
start screen of the DVD. Instructions for this are provided on the following
pages. You can also start the installation program by double-clicking the
Setup.exe file in the Driver and Toolkit\USB Diagnostic Driver
directory of the Communication Solutions DVD.

The installation program contains all components needed for the installation
of the drivers under Windows XP, Windows Vista, Windows 7, Windows 8
and Windows 10. It detects, whether the 32 bit or the 64 bit driver needs to
be installed.

Please note the following:

e Always use the installation program, if possible, to install the USB driver,
as described on the following pages.

o If older USB driver versions are installed on your system, uninstall them
first before you install the new version.

¢ Install the USB driver before you connect your communication module to
your Windows PC via USB cable (“software first” principle).

o After installing the USB driver and connecting your communication
module via USB cable, check in the Windows Device Manager if the
driver has been correctly installed and if Windows recognizes the
connected communication module.

Note: Before you can use the USB interface of your communication
module, you not only need to install the USB drivers, you also need to
install the module in its host system, PC or Evaluation Board, connect it to
a voltage supply and make sure that it is loaded with its firmware.

When you connect the module to the PC via USB cable, Windows can
identify the appropriate USB driver only if a firmware is running on the
module. Usually, Hilscher communication modules are shipped with their
firmware already loaded. However, you will find information on how to load
or update the firmware of your communication module in the user manual

= comX — Communication Modules for Real-Time-Ethernet and Fieldbus,
DOC100903UMxXEN

or

= netJACK Communication Module — Installation, Operation and
Hardware Description, DOC110504UMXxXEN.
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3.2 Installing USB Driver

3.2.1 Installing USB Driver under Windows XP
3.21.1 Installing USB Driver by Installation Program

1. Start the USB driver installation program.

» Double-click the Communication-Solutions.exe file in the root
directory of the un-zipped Communication SolutionsDVD.

 The Flash start screen Communication Solutions is displayed:

Communication Solutions

Installation Guide
Install SYCOM.net Configuration Software
Documentation
Drivers, Software and Tools
Install cifi / netJACK Device Driver
Install USB Diagnosis Driver
Ingtall USB SPM Driver
Start netHOST for Remote access
Install Slave Configuration Software
Crriver-Toolkit for Programmers

Auxiliary Tools

A ¢ANcpes (C-Link Deviceitet EthercAT™ Etheri‘et/IP —
LT pEEEn" e : = n D

. S OMMUNICATION

Figure 60: Start Screen Communication Solutions — Install USB Driver

> In the menu, select Drivers, Software and Tools > Install USB
Diagnosis Driver.

_) Note: Alternatively, you can also start the USB driver installation program
(i. e. the Device Driver Installation Wizard) by double-clicking the
setup.exe file in the Driver and Toolkit\USB Diagnostic Driver
folder of the Communication Solutions DVD.
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2 The Device Driver Installation Wizard (i. e. the USB driver installation

program) opens:

Device Driver. Installation Wizard

Tao continue, click Nest.

< Back

Welcome to the Device Driver
Installation Wizard!

Thig wizard helps you install the software drivers that some
computers devices need in order to wark,

[ Mest: |[ Cancel

Figure 61: Device Driver Installation Wizard — Start Screen

2. Start the installation.
> Click Next.

R The installation of the USB drivers is started.

Device Driver, Installation Wizard

The drivers are now installing. ..

Q4

L2

< Back

L7

Pleaze wait while the drivers install. This may take some time to complete.

Hest >

Figure 62: Device Driver Installation Wizard — Driver Are Installing
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2 After installation, the Completing the Device Installation Wizard
window appears:

Device Driver, Installation Wizard

Completing the Device Driver
Installation Wizard

The drivers were succeszsiully ingtalled on thiz computer.

'ou can now connect pour device o this computer, IF pour device
came with instructions, pleaze read thern first.

Dirivver Mame Statuz
w Hilscher GribH [netx10s..  Ready to use
s’ Hilzcher GmbH [hiluzbze... Readp to uze
w Hilscher GribH [libuzb0] ... Ready to uze

I Finigh ll Cancel l

Figure 63: Device Driver Installation Wizard — Installation Completed

> Click Finish.

_} Note: Under Windows XP, the installation process is not yet finished after
having executed the Device Driver Installation Wizard.
The installation process has to be completed in the Found New
Hardware Wizard, which automatically opens when you connect the
communication module to a PC via USB cable for the first time.

3. Complete the installation in the Found New Hardware Wizard.

» Connect your communication module via USB cable to your Windows
PC.

R The Found New Hardware Wizard starts:

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard
Windows will search for current and updated software by

looking on your cormputer, on the hardware installation CD. or on
the Windows Update web site [with your permiszian).

Read our privacy policy

Cah windows connect to ‘Windows Update to zearch for
software?

() Yes. this time only
(7 Yes, now and every time | connect a device

@

Click Mext to continue.

I Mest » l’ Cancel

Figure 64: Found New Hardware Wizard — USB Driver (1)
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» Answer the question Can Windows connect to Windows Update...?,
by selecting the No, not this time option.

» Click Next.
2 The window with the installation options appears:

Found New Hardware Wizard

Thiz wizard helpz pou inztall software for;

Hilzcher netJACk,

\'} If your hardware came with an installation CD
&2 or floppy disk. insert it now.

w'hat do pou want the wizard to do’Y

(®nstall the software automatically [Fecommended)

() Install fram a list or gpecific location [Advanced)

Click. Mext to contitiue.

l < Back " Mext » l[ Cancel

Figure 65: Found New Hardware Wizard — USB Driver (2)

» If you have already executed the installation program for the USB driver
(as recommended), you can ignore the wizard’s request to insert a CD
or floppy disk. Answer the What do you want the wizard to do?
guestion by selecting the Install the software automatically option.

» Click Next.
2 Windows copies the driver files to the Windows directories.

Found New Hardware Wizard

Pleaze wait while the wizard inztalls the software. . o

(3 Hilscher netlACK,

= -

Setting a system restore paint and backing up old filez in
caze pour syztem needs o be restored in the future,

Figure 66: Found New Hardware Wizard — USB Driver (3)

Software Installation comX and netJACK | Installing Drivers and Configuration Software
DOC130405UMO02EN | Revision 2 | English | 2017-04 | Released | Public © Hilscher 2013 - 2017



USB Driver

55/147

2 The Completing the Found New Hardware Wizard window appears:

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finizhed installing the software for;

3 Hilzcher netlACK,

Click. Finizh to cloze the wizard.

Figure 67: Found New Hardware Wizard — USB Driver (4)

> Click Finish.

 The installation of the USB driver is now complete.
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Checking Installation

After having installed the USB driver

and having connected the

communication module via USB cable, you should check in the Windows
Device Manager if the driver has been correctly installed and if Windows

recognizes the communication module.

1. Open the Device Manager.

> In the Start menu of Windows, select Control Panel.

> The Control Panel opens:

B Control Panel

File Edit  Wiew

\_) Back -\_)

Favorites  Tools  Help

Lﬁ; pSearch H__ Falders v

Address [} Control Panel

= Mame =~
ﬂ"" Control Panel b3 anternet Options
&Keyboard
[} Swikch bo Category Wiew ) Mause
@_Network Connections
LPhone and Mademn Options
See Also {‘hpower Cptions

2y Printers and Faxes

Q Regional and Language Options
Ia.Scanners and Cameras

[ 5cheduled Tasks

@ Security Center

Oscundmaz audicese

'D; Sounds and Audio Devices

4 speech
L System
aTaskbar and Stark Menu
ﬁUser Accounts

a Windows CardSpace

%‘I windows Firewall

=255 Wireless Nebwork Setup Wizard

& Windows Update
Q) Help and Suppart

V|GD
~

Configure your Internet displa. ..
Customize vour kevboard setti.,,
Customize your mouse setking. ..
Connects ko other computers, ...

Camments

Configure your telephone diali. ..
Configure energy-saving setti. ..
Shows installed prinkers and Fa. ..
Customize settings for the disp...
&dd, remove, and configure sc...
Schedule computer kasks to ru...
View wour current secarity skat,..
Soundra AudicESP settings
Change the sound scheme For ..,
Change settings for text-to-sp..,
See information about your ca...
Customize the Start Menu and ...
Change user account settings ...
Yerwalten Sie die zum Anmelde. ..
Configure the Wwindows Firewall
Set up or add to a wireless net. .,

W

Figure 68: Control Panel

» Inthe Control Panel, double-click System.
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» The System Properties sheet opens:

System Properties

Syztem Restore Automatic Updates Remote
General Computer Mame | i Advanced

Device Manager

The Device Manager lists all the hardware devices installed
= on vaur computer. Use the Device Manager to change the
properties of any device.

Device Manager

Dirivers

Diriver Signing lets you make sure that installed drivers are
compatible with Windows, “Windows Update letz vou zet up
how windows connects to windows Update for drivers.

[ Diriver Signing l [ Windows Update

Hardware Profiles

Hardware profiles provide a way for you to zet up and store
different hardware configurations.

[ Hardware Prafiles l

I Ok H Cancel ]

Figure 69: System Properties

» Inthe System Properties sheet, select Hardware tab.
» Inthe Hardware tab, click Device Manager.
 The Device Manager starts:

£ Device Manager

File  Action Wew Help
& B =ma

‘¢ Computer -~
g Disk drives ]
§ Display adapters
s DWDJCD-ROM drives
= Floppyy disk controllers
ﬁ. Floppy disk drives
8 Human Interface Devices
=3 IDE ATASATAPT controllers
“# Kevboards
7y Mice and other painting devices
+- & Manitors
+ - B8 Metwork adapters
= Parks (COM & LPT)
# Zommunications Pork (COM1)
A ECP Printer Port (LPT1)
B Hilscher netls 14}
# InteliR) Active Management Technology - 0L (COM3)
+ ﬂ. Processars
+- @), Sound, video and game controllers

System devices
+ Universal Serial Bus contrallers w

] O O i = M

+

Figure 70: Display of USB Connection in Device Manager
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2. Check if the communication module is recognized.
» Click on the plus symbol in front of the Ports (COM & LPT) entry.

2 A netJACK NJ 100EN-RE communication module for instance will be
displayed as Hilscher netJACK, with the currently used COM port
indicated in brackets.
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3.2.2 Installing USB Driver under Windows 7
3.2.2.1 Installing USB Driver by Installation Program

1. Start the USB Driver setup program.

» Double-click the Communication-Solutions.exe file in the root
directory of the un-zipped Communication SolutionsDVD.

 The Flash start screen Communication Solutions is displayed:

Communication Solutions

Installation Guide
Install SYCOM.net Configuration Software
Documentation
Drivers, Software and Tools
Install cifi / netJACK Device Driver
Install USB Diagnosis Driver
Ingtall USB SPM Driver
Start netHOST for Remote access
Install Slave Configuration Software
Crriver-Toolkit for Programmers

Auxiliary Tools

AA ¢ANcpes (C-Link Deviceitet EthercAT™ Etheri‘et/IP —
R pEEEn" e : = n D

. S OMMUNICATION

Figure 71: Start Screen Communication Solutions — Install USB Driver

> In the menu, select Drivers, Software and Tools > Install USB
Diagnosis Driver.

Note: Alternatively, you can also start the USB driver setup program (i. e.
the Device Driver Installation Wizard) by double-clicking the setup.exe
file in the Driver and Toolkit\USB Diagnostic Driver folder of
the Communication Solutions DVD.
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2 The Device Driver Installation Wizard (i. e. the USB driver installation

program) opens:

Device Driver Installation Wizard

- Welcome to the Device Driver
Installation Wizard!

Thig wizard helps you install the software drivers that some
computers devices need in order to wark.

Back [ Net> | | Cancel

Figure 72: Device Driver Installation Wizard — Start Screen

2. Start the installation.
> Click Next.
R The installation of the USB drivers is started.

Device Driver Installation Wizard

"

The drivers are now installing...

o =

Flease wait while the drivers ingtall. This may take some time to complete.

Figure 73: Device Driver Installation Wizard — Drivers Are Installing
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2 After installation, the Completing the Device Installation Wizard
window appears:

Device Driver Installation Wizard
- Completing the Device Driver
Installation Wizard

The drivers were successfully installed on this computer.

You can now connect your device to this computer. § your device
came with instructions, please read them first.

Driver Mame Status

w* Hilscher GmbH (net<10s... Readyto use
»” Hilscher GmbH fhilusbse... Readyto use
w* Hilscher GmbH (ibusb0) ... Readyto use

cBack [ Finsh | [ Caneel |

Figure 74: Device Driver Installation Wizard — Installation Completed

» Click Finish.
2 The installation of the USB driver is completed.

Note: By completing the Device Driver Installation Wizard, the
installation process under Windows 7 is practically finished.
When you connect the communication module to the PC via USB cable
for the first time, the Installing device driver software message appears
in the Windows task bar. Windows then copies the driver files to the
appropriate Windows directories. This is an automated process, you do
not need to take any action in this. Finally, the Device driver software
installed successfully message appears in the task bar.
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Checking Installation

After having installed the USB driver and having connected the
communication module via USB cable, you should check in the Device
Manager of Windows 7 if the driver has been correctly installed and if
Windows recognizes the communication module.

1. Open the Device Manager.
> In the Windows Start menu, select Control Panel.
2 The Control Panel opens:

=N R~

o | s | | |Search Control Panel Jol |

O@v@ v Contrel Panel »

Adjust your computer’s settings

View by: Category ~

System and Security

Review your computer's status

User Accounts
'5' Change account type
Back up your computer )

Find and fix problems Appearance and

Network and Internet Personalization

View network status and tasks
Cheose homegroup and sharing
options

u:l

Change the theme
Change desktop background
Adjust screen resclution

Clock, Language, and Region

8,
A,

, / Hardware and Sound
ﬁ‘ View devices and printers Change keyboards or other input
' Add a device methods
Change display language
E—% Programs
4 Uninstall a program Ease of Access
L Get programs Let Windows suggest settings

Optimize visual display

Figure 75: Adjust Your Computer’s Settings Window

» Inthe Control Panel, click Hardware and Sound.
? The Hardware and Sound window opens:

@Uv|gﬁ » Contrel Panel » Hardware and Sound »

- | g | | Search Control Panel

Control Panel Home § z .
/ Devices and Printers

‘#I"BI Add adevice | Addaprinter | Mouse "\“:;f' Device Manager

System and Security

Network and Internet AutoPlay

Change default settings for media or devices
Play CDs or other media automatically

# Hardware and Sound

Programs
Sound
Adjust system volume

User Accounts i i
Change system sounds | Manage audic devices

Appearance and

Personalization Power Options

Clock, Language, and Region Change power-saving settings | Change what the power buttens de

. Require a password when the computer wakes

Change when the computer sleeps | Choose a power plan

Display
Make text and other items larger or smaller
Connect to an external display

Adjust screen reselution
How to correct monitor flicker (refresh rate)

Figure 76: Hardware and Sound Window
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» Inthe Devices and Printers group, click Device Manager.
 The Device Manager starts:

=y Device Manager EI@

Eile Action VNiew Help
e @ EIHm & E S

a5 im01wind

b v¥ CIF Communication Interface
> 78 Computer

g Disk drives

- B Display adapters

> -4 DVD/CD-ROM drives

> = Floppy disk drives

> tH Floppy drive controllers

» 5»3 Human Interface Devices

b g IDE ATAJATAPI controllers

b &2 Keyboards

b }f!, Mice and other pointing devices
b - Monitors

:s ¥ Network adapters

» -3 Other devices

JT Ports (COM BLLPT)

S

b D Processors

b % Sound, video and game controllers
b M Systemn devices

b- ¥ Universal Serial Bus controllers

Figure 77: Display of USB Connection in Device Manager

2. Check if the communication module is recognized.
» Click on the triangle in front of the Ports (COM & LPT) entry.

2 A netJACK NJ 100EN-RE communication module for instance will be

displayed as Hilscher netJACK, with the currently used COM port
indicated in brackets.
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3.2.3 Installing USB Drivers under Windows 8
3.2.3.1 Installing USB Driver by Installation Program

1. Start the USB Driver setup program.

» Double-click the Communication-Solutions.exe file in the root
directory of the un-zipped Communication SolutionsDVD.

 The Flash start screen Communication Solutions is displayed:

Communication Solutions

Installation Guide
Install SYCOM.net Configuration Software
Documentation
Drivers, Software and Tools
Install cifi / netJACK Device Driver
Install USB Diagnosis Driver
Ingtall USB SPM Driver
Start netHOST for Remote access
Install Slave Configuration Software
Crriver-Toolkit for Programmers

Auxiliary Tools

A ¢ANcpes (C-Link Deviceitet EthercAT™ Etheri‘et/IP —
LT pEEEn" e : = n D

. S OMMUNICATION

Figure 78: Start Screen Communication Solutions — Install USB Driver

> In the menu, select Drivers, Software and Tools > Install USB
Diagnosis Driver.

Note: Alternatively, you can also start the USB driver setup program (i. e.
the Device Driver Installation Wizard) by double-clicking the setup.exe
file in the Driver and Toolkit\USB Diagnostic Driver folder of
the Communication Solutions DVD.
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> The Device Driver Installation Wizard (i. e. the USB driver installation
program) opens:

Welcome to the Device Driver
Installation Wizard!

This wizard helps you install the software drivers that some
computers devices need in order to work.

To continue, click Next.

cBack [ Neds | | Cancel

Figure 79: Device Driver Installation Wizard — Start Screen

2. Start the installation.
» Click Next.
R The installation of the USB drivers is started.

The drivers are now installing... .

Please wait while the drivers install. This may take some time to complete.

Figure 80: Device Driver Installation Wizard — Drivers Are Installing
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R After installation, the Completing the Device Installation Wizard
window appears:

Completing the Device Driver
Installation Wizard

The drivers were successfully installed on this computer.

You can now connect your device to this computer. f your device
came with instructions, please read them first.

Driver Name Status

w" Hilscher GmbH {netc10ser) Ports ... Readyto use
w" Hilscher GmbH fhilusbser) Ports (... Readyto use
£

< Back Cancel

Figure 81: Device Driver Installation Wizard — Installation Completed

» Click Finish.
2 The installation of the USB drivers is completed.

Note: By completing the Device Driver Installation Wizard, the
installation process under Windows 8 is practically finished. When you
connect the communication module to your PC via USB cable for the first
time, the following symbol appears in the task bar (visible only if you are in
the “desktop mode” of Windows 8):

®

Windows then copies the driver files to the appropriate Windows
directories. This is an automated process, you do not need to take any
action in this.
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3.2.3.2 Checking Installation

After having installed the USB driver and having connected the
communication module via USB cable, you should check in the Device
Manager of Windows 8 if the driver has been correctly installed and if
Windows recognizes the communication module.

1. Open the Control Panel.
» In the Start screen of Windows 8, right-click on an empty space.
2 The All apps button appears in the lower part of the screen:

All apps

Figure 82: All Apps Button

» Click All apps.
2 A list featuring all available programs (Apps) appears:

7-Zip File Manager = Off [ Steps Recorder v Command Prompt
Office-Dokument ¢ | 7-Zip Help L dic fice Sticky s Computer
* | sifnen 3
People i i s Control Panel

{  Notepad++ i Windows Journal fj Default Programs

ws Media File Explorer

—

SkyDrive a ore 0 Calculator | WordPad @ Help and Support
H

Sports " ffice Character Map ewe = Run
Store | Mi ft Offi Math Input Panel X g Task Manager

Magnifier

ﬁ Narrator

Snipping Toel

Figure 83: List of Installed Apps in Windows 8

» Inthe Apps list, click Control Panel.
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2 Windows 8 changes into “desktop mode” and opens the Control Panel:

1 B+ Control Panel »

Adjust your computer’s settings

System and Security

Review your computer's status

Save backup copies of your files with File
History

Find and fix problems

Network and Internet
View network status and tasks
Cheoose hemegroup and sharing options

Hardware and Sound

|5r:arch Control Panel

v &

View by: Category *

User Accounts
@' Change account type

Appearance and Personalization
Change the theme

Change desktop background

Adjust screen reselution

Clock, Language, and Region
Add a language

Change input metheods

View devices and printers .
Change date, time, or number formats

Add a device

Ease of Access
Let Windows suggest settings
Optimize visual display

Programs
Uninstall a pregram
Get programs

2,
N,
@

Figure 84: Control Panel

2. Open Device Manager.
> In the Control Panel, click Hardware and Sound.
2 The Hardware and Sound window opens:

@ -~ b % » Control Panel » Hardware and Sound » v & Search Control Panel

Control Panel Home z .
Devices and Printers

Add a device | Advanced printer setup
Change Windows To Ge startup options

Mouse @Device Manager

System and Security

Metwork and Internet
Hardware and Sound

AutoPlay

Change default settings for media or devices | Play CDs or other media automatically

Programs
Sound
Adjust system volume

User Accounts

Change system sounds | Manage audic devices

Appearance and
Personalization Power Options

Change power-saving settings | Change what the power buttons do

Require a password when the computer wakes | Change when the computer sleeps

Choose a power plan

Clock, Language, and Region

Ease of Access

Display
Make text and other items larger or smaller
How to correct monitor flicker (refresh rate)

Adjust screen resolution

Location Settings
Change location settings

Figure 85: Hardware and Sound
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» Inthe Devices and Printers group, click Device Manager.
2 The Device Manager starts:

Eile Action Miew Help

o= @ E HE 8 ESYS
a = im0lwind

> |8 Computer
= Disk drives

l;" Display adapters
o DVD/CD-ROM drives
< Floppy disk drives
L:E Floppy drive controllers
ﬂﬁ Human Interface Devices
@ IDEATA/ATAPI controllers
= Keyboards
E! Mice and other pointing devices
| Monitors
El? Metwork adapters
) Other devices
3 Ports (COM & LPT)
"3 ECP-Druckeranschluss (LPT1)
[ Hilscher net/ ACK (COM4) |
T’? Kommunikationsanschluss (COMT)
[ @ Print queues
[ R Processors
I» iﬂ' Sound, video and game controllers

[
[»
[»
[+
[
[
[+
[
[
[+
[
[»
4

3 (} Storage controllers
[ 1M Systern devices
[ i Universal Serial Bus controllers

Figure 86: Display of USB Connection in Device Manager

3. Check if the communication module is recognized.
» Click on the triangle in front of the Ports (COM & LPT) entry.

2 A netJACK NJ 100EN-RE communication module for instance will be
displayed as Hilscher netJACK, the currently used COM port is
indicated in brackets.
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3.2.4 Installing USB Driver under Windows 10
3.24.1 Installing USB Driver by Installation Program

1. Start the USB Driver setup program.

» Double-click the Communication-Solutions.exe file in the root
directory of the un-zipped Communication SolutionsDVD.

 The Flash start screen Communication Solutions is displayed:

Communication Solutions

Installation Guide
Install SYCON.net Configuration Software
Documentation
Drivers, Software and Tools
Install cifX / netJACK Device Driver
Install USB Diagnosis Driver
Install USB SPM Driver
Start netHOST for Remote access
Ingtall Slave Configuration Software
Driver-Toolkit for Programmers

Auxiliary Tools

@ CANcpen CC'Lfﬂk Devicei'et Fther€AT. ™ Etheri'et/IP .
Lo RNET o IR [0 > G - =i n )
N M 20 sercos 3 Bl oo

. - COMMUNIGATION

Figure 87: Start Screen Communication Solutions — Install USB Driver

> In the menu, select Drivers, Software and Tools > Install USB
Diagnosis Driver.

Note: Alternatively, you can also start the USB driver setup program (i. e.
the Device Driver Installation Wizard) by double-clicking the setup.exe
file inthe Driver and Toolkit\USB Diagnostic Driver folder of
the Communication Solutions DVD.
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> The Device Driver Installation Wizard (i. e. the USB driver installation

program) opens:

Device Driver Installation Wizard

Welcome to the Device Driver
Installation Wizard!

This wizard helps you install the software drivers that some
computers devices need in order to worlk.

To continue, click Next.

cBack | Nedt> | Cancel

Figure 88: Device Driver Installation Wizard — Start Screen

2. Start the installation.
> Click Next.
R The installation of the USB drivers is started.

2 After installation, the Completing the Device Installation Wizard

window appears:

Device Driver Installation Wizard

Completing the Device Driver
Installation Wizard

The drivers were successfully installed on this computer.

You can now connect your device to this computer. f your device
came with instructions, please read them first.

Driver Name Status

w" Hilscher GmbH {netx10s... Readyto use
s Hilscher GmbH fhilusbse... Readyto use
s Hilscher GmbH {ibusb0) .. Ready to use

< Back Cancel

Figure 89: Device Driver Installation Wizard — Installation Completed

» Click Finish.
2 The installation of the USB driver is completed.
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3.24.2

Note: By completing the Device Driver Installation Wizard, the
installation process under Windows 10 is practically finished.

When you connect the communication module to the PC via USB cable
for the first time, the following icon appears in the Windows task bar:

Windows then copies the driver files to the appropriate Windows
directories. This is an automated process, you do not need to take any
action in this.

Checking Installation

After having installed the USB driver and having connected the
communication module via USB cable, you should check in the Device
Manager of Windows 10 if the driver has been correctly installed and if
Windows recognizes the communication module.

1. Open the Device Manager.

» Right-click on the Windows Start symbol, then choose Device
Manager entry:

Programs and Features
Power Options

Event Viewer

Systemn

Device Manager
Metwork Connections
Disk Management
Computer Management
Command Prompt

Command Prompt (Admin)

Task Manager

Control Panel
File Explorer
Search

Run

Shut down or sign out

Desktop

Figure 90: Open Device Manager in Windows 10
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2 The Device Manager starts:

% Device Manager —

Action View Help

s T EHE B EXE

v & IMDTWin1D

I? cifX Cermmunication Interface
[ Computer

- Disk drives

& Display adapters

= Floppy disk drives

=@ Floppy drive contrallers

@ Mice and other pointing devices
[ Monitors

5 Network adapters

K7 Other devices

v B Ports (COM & LPT)

ﬁ ECP-Druckeranschluss (LPT1)
& Hilscher net]ACK (COM4)
ﬁ Kommunikationsanschluss (COMT)
= Print queues
L} Processors
0 Software devices
| Sound, video and game controllers
&y Storage controllers
§@ System devices
i Universal Senial Bus contrellers

Figure 91: Display of Communication Module in Device Manager

2. Check if the communication module is recognized.
» Click on the triangle in front of the Ports (COM & LPT) entry.
2 A netJACK NJ 100EN-RE communication module for instance will be

displayed as Hilscher netJACK, with the currently used COM port

indicated in brackets.
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3.3 Uninstalling USB Driver
3.3.1 Uninstalling USB Driver under Windows XP

If you want to uninstall the USB drivers under Windows XP, proceed as

follows:

> In the Start menu of Windows XP, select Control Panel.

> The Control Panel opens:

B Control Panel

File Edit ‘iew Favorites Tools  Help

.\_)Back -\_':J Lﬁ; pSearch H__ Falders v

Address & Control Panel

Mame =

ﬂ"" Control Panel # 6ACCBSSibi|itY Cpkions
SE ndd Hardware

[:} Swikch bo Category Wiew i emave Programs
L Adrministrative Tools
‘u Automatic Updates

See Also P ciF Setup

By ciF % Test

ﬁ wWindows Update )

“2Dake and Time
Q) Help and Support }Displav
EdFiash Player
|FFalder Options
ﬁFonts
B Game Controllers
‘ﬁIndexerstelIung
B trteltry ama oriver
9Internet Cptions
@Keyboard
) Maouse
t_‘,Network Connections
LPhone and Modem Options
3

h Install or remove pragrams an...

V|GD
~

Adjust wour computer settings ...
Installs and troubleshoots hat...

Camments

Configure administrative sektin. .
Set up windows to automatical. ..
Setup cif Boards and charnels
Test your cif¥ Boards and Cha...
Set the date, time, and time ...
Change the appearance of vo...
Manage Flash Plaver Settings
Customize the display of files a...
&dd, change, and manage fon...
&dd, remove, and configure g...
Microsoft Office Find Fast (tm). ..
Stewern Sie die Grafikhardwar..
Configure your Internet displa. ..
Customize your keyboard setti,.,
Customize your mouse setking. ..
Connects to other computers, ..
Configure vour telephone diali, ..

W

Figure 92: Control Panel

> Inthe Control Panel, double-click Add or Remove Programs entry.
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2 The Add or Remove Programs window opens:

% Add or Remove Programs [D[gl

.
il Currently installed programs: [ show updates Sart by

Change ar - Sige  Z7TOME
Remove =
Programs ﬁl Size 2.87MB
: 'i Entries from other programs
o MF° Size  335.00MB
Add Mew ;
o i Size  2.16MB
& Size  10.31MB
@l s Siee  22.42MB
AddfRemave | @ Size  0.82MB
Windows
Companents e} Size  3.60ME
@ O Sie 0.16ME
i Sze 2.91MB
Set Program .
pccessand (R Size  228,00MB
Defaults
B4 Size  7.42MEB

ows Driver Package - Hilscher GmbH (hilusbser) Ports (12/21/2012 6.0.9.0)

ram of remaove it from your computer, click ChangefRemove

FE Windows Driver Package - Hilscher GmbH (ibusb0) busb-win3z devices (12/20/2012 1.2.4.0)
FE Windows Driver Package - Hilscher GmbH (netx10ser) Porks (10012012 6,0,7.0)

| £

Figure 93: Add or Remove Programs

» Select Windows Driver Package — Hilscher GmbH (hilusbser) Ports
entry.

» Click Change/Remove.
> A security question appears:

Uninstall Driver Package

\_g/- Al devices using this driver will be removed. Do you wish ko continue?

Figure 94: Acknowledge Uninstall

» Click Yes.
2 The USB driver package is removed from your PC.

» Repeat this procedure for the remaining driver packages
Windows Driver Package — Hilscher GmbH (libusbO) [...] devices
and Windows Driver Package — Hilscher GmbH (netx10ser) Ports.
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3.3.2 Uninstalling USB Driver under Windows 7
> In the Start menu of Windows 7, select Control Panel.
> The Control Panel opens:
(=] = |ms)
O@v|@ + Control Panel » - | +y | | |Ss:f:-" Control Panel 02 [
Adjust your computer’s settings View by: Category =
gl  Systemand Security User Accounts
N 9 Review your computer's status i 'ﬁ'Change account type
h Back up your computer i
Find and fix problems Appearance and
w,_ MNetwork and Internet w Personalization
ui View network status and tasks Change the theme
- Choose homegroup and sharing options Change desktop background
Adjust screen resolution
./ Hardware and Sound .
%‘ View devices and printers Clock, Language' and_ Reglon
Add 3 device & Change keyboards or other input
b methods
E—% Programs Change display language
:' i‘ gninstall a program ) _..—..__‘ Ease of Access
et programs ( \ ) .
I | Let Windows suggest settings
\—/ Optimize visual display
Figure 95: Adjust Your Computer’s Settings Window
» Inthe Programs group, click Uninstall a program.
2 The Uninstall or change a program window opens:
E=% EEB
@Uv <« Programs » Programs and Features - | g | | Search Programs and Features pe [
Control Panel H .
e ane Uninstall or change a program
View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or
'5' Turn Windows features on or Repair.
off
Install a program from the Organize +  Uninstall/Change 1= - I@l
network =
Name at
x|
=1 Entries from other programs
x|
x|
@
=
=
etz
k. =
|
o
=
& Windows Driver Package - Hilscher GmbH (hilusbser) Ports (12/21/2012 6.0.9.0)
= Windows Driver Package - Hilscher GmbH (libusb0) libusb-win32 devices (12/20/20121.24.
= Windows Driver Package - Hilscher GmbH (netdOser) Ports (10,/01/2012 6.0.7.0) -
< | 1 | +
§' Hilscher GmbH Product version: 12/21/2012 6.0.9.0
= <N

Figure 96: Uninstall or Change a Program
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» Select Windows Driver Package — Hilscher GmbH (hilusbser) Ports
entry.
» Click Uninstall/Change button located above the list.

2 A security question appears:

Uninstall Driver Package 3

'el All devices using this driver will be removed. Do you wish to continue?

Figure 97: Acknowledge Uninstall

» Click Yes.
2 The USB driver package is removed from your PC.

> Repeat this procedure for the remaining driver packages
Windows Driver Package — Hilscher GmbH (libusbO) [...] devices
and Windows Driver Package — Hilscher GmbH (netx10ser) Ports.
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3.3.3 Uninstalling USB Driver under Windows 8

1. Open the Control Panel.
» In the Start screen of Windows 8, right-click on an empty space.
2 The All apps button appears in the lower part of the screen:

All apps

Figure 98: All Apps Button

» Click All apps.
2 A list featuring all available programs (Apps) appears:

N Sound Recorder
7-Zip File Manager = ft Office m Steps Recorder e Command Prompt

Computer

2 @

Office-Dokument | 7 A e . Sticky Notes

dffnen

ﬁ.

People Control Panel

®

{  Notepad++ Default Programs

I

| Reader File Explorer

.E.

Help and Support

SkyDrive 2] i ft Office Calculator

SN B

Sports " icrosoft Office Character Map Run

o P

Store [ Office Math Input Panel Task Manager

Magnifier

o

"
b1
iz

Video 2 2 Paint Marrator

® @

e | Weather

Snipping Toel

L |

Figure 99: List of Installed Apps in Windows 8

» Inthe Apps list, click Control Panel.
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2 Windows 8 changes into “desktop mode” and opens the Control Panel:

4+ & + Control Panel »

Adjust your computer’s settings

System and Security

Review your computer's status

Save backup copies of your files with File
History

Find and fix problems

_ Network and Internet
| View network status and tasks
Cheose hemegroup and sharing eptions

Hardware and Sound
View devices and printers
Add a device

Programs
Uninstall a program
Get programs

£
N,
®

Figure 100: Control Panel

|Search Control Panel

v o
View by: Category =

User Accounts
@ Change account type

Appearance and Personalization
Change the theme

Change desktop background

Adjust screen resolution

Clock, Language, and Region
Add a language

Change input metheds

Change date, time, er number formats

Ease of Access
Let Windows suggest settings
Optimize visual display

2. Open Programs and Features window.
» In the Programs group of the Control Panel, click Uninstall

program.

2 The Programs and Features window opens:

* 4 |5l « Programs » Programs and Features

Control Panel Home

View installed updates

v Search Programs and Features 0

Uninstall or change a program

@' Turn Windows features on or

off

Organize *  Uninstall/Change

Install a program from the

network

MName

To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.

Entries from other programs

|xWindaws Driver Package - Hilscher GmbH (hilusbser) Ports (12/21/2012 6.0.9.0)

E Windows Driver Package - Hilscher GmbH (libusb0) libush-win32 devices (12/20/2012 1.2.4.0)
& Windows Driver Package - Hilscher GmbH (netx10ser) Ports (10/01/2012 6.0.7.0)

<

§ Hilscher GmbH Product version:  12/21/2012 6.0.9.0
=

Figure 101: Uninstall or Change a Program
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3. Uninstall driver packages.

» Select Windows Driver Package — Hilscher GmbH (hilusbser) Ports
entry.

» Click Uninstall/Change button located above the list.
2 A security question appears:

Uninstall Driver Package H

o All devices using this driver will be removed. Do you wish to continue?

Figure 102: Acknowledge Uninstall

» Click Yes.
» The USB driver package is removed from your PC.

» Repeat this procedure for the remaining driver packages
Windows Driver Package — Hilscher GmbH (libusbO0) [...] devices
and Windows Driver Package — Hilscher GmbH (netx10ser) Ports.
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3.34 Uninstalling USB Driver under Windows 10

1. Open the Programs and Features dialog window.

» Right-click on the Windows Start symbol, then choose Programs and
Features entry:

Programs and Features
Power Options

Event Viewer

System

Device Manager
Metwork Connections
Disk Management
Computer Management
Command Prompt

Command Prompt (Admin}

Task Manager
Control Panel
File Explorer
Search

Run

Shut down or sign out

Desktop

Figure 103: Open program manager in Windows 10
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2 The Uninstall or change a program

window opens:

& Pregrams and Features

Control Panel Home

View installed updates

& Turn Windows features on or
off

Install a program from the
network

1 [@ » Control Panel » Programs » Programs and Features

Uninstall or change a program

To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.

v O

Search Programs and Features @

- [m]

Organize *  Uninstall/Change - o
Name . Publisher Installed On  Size Version
Fiz| 1 LR ]
[ ~ - wall LE |
[ === = e
B ey e " pa M i
G ek o i e Mo L LS. ] L
Qi = X |
D [ LR B T | (LR uf
& Windows Driver Package - Hilscher GmbH (hilusbser) Ports (0. Hilscher GmbH 47372017 09/18/2015 6.0.16.0
E Windows Driver Package - Hilscher GmbH {libusb0) libusb-win... Hilscher GmbH 47372017 09/18/20141.2.10.0
E Windows Driver Package - Hilscher GmbH (net10ser) Ports (0. Hilscher GmbH 47372017 07/15/2013 6.09.0
=) - - - [ i - r .
=] B e g — - --n
IS Sra—— ¥ = = om i mgem I . B
= = r o - | - u " [} L 1

%ﬂ Hilscher GmbH Product version: 09/18/2015 6.0.16.0

=

Figure 104: Uninstall or change a program window

>

>

Select Windows Driver Package — Hilscher GmbH (hilusbser) Ports
entry.

Click Uninstall/Change button located above the list.

2 A security question appears:

Uninstall Driver Package

o All devices using this driver will be removed. Do you wish to continue?

Yes . No
Figure 105: Acknowledge Uninstall
» Click Yes.
» The USB driver package is removed from your PC.
» Repeat this procedure for the remaining driver packages

Windows Driver Package — Hilscher GmbH (libusb0) [...] devices
and Windows Driver Package — Hilscher GmbH (netx10ser) Ports.
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4 SYCON.net
41 Overview

With the SYCON.net configuration software, you can configure and
diagnose your communication module. You can also use it to download or
update the firmware of your module.

If the host system of your communication module runs under a Windows
operating system, you can install SYCON.net directly on your host system
for the above mentioned purposes. You can also install SYCON.net on a
separate configuration PC under Windows, and then connect your
communication module via PCI Carrier Board (comX), Evaluation Board
(netJACK), USB or serial interface to the configuration PC and SYCON.net.

SYCON.net is delivered on the Communication Solutions DVD. You can
start the installation program for SYCON.net (the SYCON.net for netX
InstallShield Wizard) in the menu of the start screen of the DVD.
Instructions for this are provided on the following pages. You can also start
the installation by double-clicking the SYCONnet netX setup.exe file in the
Software\SYCON.net directory of the Communication Solutions DVD.
The installation program contains all components needed for the installation
under Windows XP, Windows Vista, Windows 7, Windows 8 and
Windows 10.

Please note the following:

e If SYCON.net shall access the communication module via host interface
or PC bus, you need to install the cifX Device Driver on your host system
or configuration PC. See cifX Device Driver chapter on page 10.

¢ If SYCON.net shall access the communication module via USB, you
need to install the USB Driver on your host system or configuration PC.
See USB Driver chapter on page 50.

¢ You need administrator rights for installing or uninstalling SYCON.net on
your operating system.

¢ If an older version of SYCON.net is already installed on your system,
uninstall it first, before you install the new version. See Uninstalling
SYCON.net section on page 108.
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4.2 System Requirements

To install and use SYCON.net, the following requirements must be met:

PC with 1 GHz processor or higher

Windows® XP SP3,

Windows® Vista (32 bit) SP2,
Windows® 7 (32 bit and 64-Bit) SP1,
Windows® 8 (32-Bit and 64-Bit),
Windows® 8.1 (32-Bit and 64-Bit),
Windows® 10 (32-Bit and 64-Bit)

Administrator privilege required for installation
Microsoft .NET Framework 4.0

Internet Explorer 5.5 or higher

Free disk space: min. 400 MByte

RAM: min. 512 MByte, recommended 1024 MByte
Graphic resolution: min. 1024 x 768 pixel
Keyboard and Mouse

USB, serial or Ethernet interface

Restriction: Touch screen is not supported.

Note: If the project file is used on another PC,
= the other PC must also comply to these system requirements,
= the device description files of the devices used in the project must be

imported to the configuration software SYCON.net on the other PC,

= respectively the DTMs of the devices used in the project must be in-

stalled on the other PC.
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4.3 Installing SYCON.net
4.3.1 Installing SYCON.net under Windows XP

85/147

1. Start the SYCON.net installation program.

> Double-click the Communication-Solutions.exe file in the root
directory of the un-zipped Communication SolutionsDVD.

> The Flash start screen Communication Solutions is displayed:

Communication Solutions

Installation Guide

Install SYCOM.net Configuration Software
Documentation

Drivers, Software and Tools

y 4
POWERLINK Modbus  SE0E y: - Serco hilscher

Ul the sunomation bus COMPETENCE IN

WA
. CONMMUNICATION

Figure 106: Start Screen Communication Solutions — Install SYCON.net

» Click on Install SYCON.net Configuration Software.

_} Note: As an alternative, you can also start the SYCON.net installation
program (i. e. the SYCON.net for netX InstallShield Wizard) by double-

clicking the SYCONnet netX setup.exe file in the SofFtware\SYCON.net
directory of the Communication Solutions DVD.

? The SYCON.net installation program is started.
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2. Choose language for the setup.

Wihlen Sie eine Setup-Sprache aus

‘Wwahlen Sie die Sprache dieser Installation aus der unten
@ aufgefihrten Auzwahl aus.

[ ok ][ abbrechen |

Figure 107: SYCON.net Setup Language
» Select the language for the setup.

> Click OK.

> The SYCON.net for netX InstallShield Wizard opens:

i'-.% SYCON. net for netX - InstallShield Wizard

Welcome to the Installshield Wizard for
SYCON.net for netx

The InstallShigld(R) Wizard will install 5% COM.net For nets,
wersion 1.x an your computer, Ta continue,
click Mext.

WaRNING: This program is prokected by copyright law and
inkernational treaties,

« Back, [ Mext> [ Cancel

Figure 108: SYCON.net Installation Program

» Click Next.
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3. Read the notes about major changes in SYCON.net.

5 SYCON. net for, netX - InstallShield Wizard

Important Information

Please read the Followinig information carefully. %

MNotes about major changes in SYCON.net V1.x

Flease read these notes carefully, since they contain important information about
majar changes in SYCOR.net.

Overview
1. Concerns comX Communication Modules
1.1. Opening old SYCOMN.net Project Files

2.  Concerns cif¥ Communication Interfaces and com¥ Communication
Modules b

©f i

()1 have not read the information wet

[ < Back “ Mext = ] [ Cancel ]

Figure 109: Notes About Major Changes in SYCON.net
» Read the notes about major changes in SYCON.net carefully.
» Select | read the information after you have read them.

> Click Next.

4. Accept license agreement.

i SYCON. net for net¥ - InstallShield Wizand

License Agreement

Please read the Following license agreement carefully, |~<h

HILSCHER SOFTWARE LICENSE AGREEMENT ~

Thiz document is a legally walid contract betveen yvou and Hilscher Gesellschaft for
Systemautomation mbH ("Hilzcher'").

Please read through this License SAgreement carefully before installing and using the
software, By instaling the software and using it, whether in whole or in part, vou accept all
of the provisions of this Agreement.

If you decline to accept these terms and conditions, please do not install the software.
Instead, return it to us or the retailer from swhich you purchazed it for @ refund of the
purchase price. i~

(21 accept the terms in the license agreement:

(7)1 do not accept the terms in the license agreement

[ < Back ” Mexk = l [ Cancel

Figure 110: SYCON.net License Agreement

» Select | accept the terms in the license agreement, if you agree to it.
» Click Next.
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5. Enter user information.

i'—_{—" SYCON. net for netX - InstallShield Wizard

Customer Information

Please enter vour information,

User Mame:
|Llser N,lame

Organization:

|Organi2ati0n

[ < Back ” Mext = ] [ Cancel

Figure 111: SYCON.net Customer Information

» Enter the user name and the name of the organization.
» Click Next.

6. Select setup type.

fi? SYCON. net for netX - InstallShield Wizard

Setup Type

Choose the setup bype that best suits your needs,

Flease select a setup type.

all prograr Features will be installed. (Requires the most disk
space,)

Choose which program features vou want installed and where they
will be installed. Recammended For advanced users,

[ < Back " Mext = l [ Cancel

Figure 112: SYCON.net Setup Type

» Select Complete if you want to install the complete software.

> Click Next.
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7. Install SYCON.net.

i'-.% SYCON. net for netX - InstallShield Wizard

Ready to Install the Program

The wizard is ready to beqin installation,

Click Install to begin the installation,

If wou want to review or chanaes any of wour installation settings, click Back, Click Cancel to
exit the wizard,

[ < Back. ]| Install i [ Carncel

Figure 113: Start SYCON.net Installation
> Click Install to start the installation.

2 The components are being installed. This may take several minutes.

i SYCON.net for netX - InstaliShield Wizard

The program Features you selected are being installed,

Installing SYCOM.net for netX ‘ ‘ |

Please wait while the Installshield Wizard installs SYCON.net for neti. This
may take several minukes,

Skatus:

Caricel |

Figure 114: SYCON.net Installation Status
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8. Finish Installation.

it SYCON.net for netX - InstallShield Wizard X

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed S¥COMN.net
far mety. Click Finish to exit the wizard,

< Back Cancel

Figure 115: Finish SYCON.net Installation

» Click Finish to complete the installation.

» SYCON.net is installed and can be started in the Start menu of
Windows by choosing All Programs > SYCON.net System
Configurator > SYCON.net.
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4.3.2 Installing SYCON.net under Windows 7

1. Start the SYCON.net installation program.
» Close all application programs.

» Double-click the Communication-Solutions.exe file in the root
directory of the un-zipped Communication SolutionsDVD.

 The Flash start screen Communication Solutions is displayed:

Communication Solutions

Installation Guide

Install SYCOM.net Configuration Software
Documentation

Drivers, Software and Tools

A ¢ANcoeo (C-Link Deviceitet EinercAT™ Etheritet/IP —
Sl PR [o] o " . il e
POWERLINK 1#Modibus Sercos & hilscher

the surometion bus COMPETENCE IN

. S COMMUNICATION

Figure 116: Start Screen Communication Solutions — Install SYCON.net

» Click on Install SYCON.net Configuration Software.

Note: As an alternative, you can also start the SYCON.net installation
program (i. e. the SYCON.net for netX InstallShield Wizard) by double-
clicking the SYCONnet netX setup.exe file in the Software\SYCON.net
directory of the Communication Solutions DVD.

You can reduce the number of Windows security questions by right-
clicking on the SYCONnet netX setup.exe file and choosing Run as
administrator from the context menu.

? The SYCON.net installation program is started.
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2. Choose language for the setup.

l’ ™
Choose Setup Language ﬂ

@ Select the lahguage for thiz installation from the choices below.
]

[Englisch (U5 -

[ oK ] [ Cancel ]

%

Figure 117: SYCON.net Setup Language

» Select the language for the setup.
» Click OK.

» The SYCON.net for netX InstallShield Wizard opens:

F ™
%) SYCON.net for netX - InstallShield Wizard [

i

Welcome to the InstallShield Wizard for
SYCON.net for netX

The InstallShield(R) Wizard will install SYCON.net for netX,
wersion 1.x on your computer, To continue,
dick Mext.

WARNING: This program is protected by copyright law and
international treaties.

< Back [ Next > ] [ Cancel ]

Figure 118: SYCON.net Installation Information

> Click Next.
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3. Read the notes about major changes in SYCON.net.

F |
1) SYCON.net for netX - InstallShield Wizard i (]

Important Information 1 ik
Please read the followinig information carefully. I

Notes about major changes in SYCON.net V1.x m

Please read these notes carefully, since they contain important information about
major changes in SYCON.net.

Overview
1. Concerns comX Communication Modules
1.1. Opening old SYCOMN.net Project Files

2. Concerns cifX Communication Interfaces and comX Communication
Modules %

(7)1 have not read the information yet

InstaliShield

[ < Back ][ Mext = ] [ Cancel ]

Figure 119: Notes about Major Changes in SYCON.net

» Read the notes about major changes in SYCON.net carefully.
» Select | read the information, after you have read them.
» Click Next.

4. Accept license agreement.

. .
1) SYCONnet for netX - InstallShield Wizard s

License Agreement 1 i
FPlease read the following license agreement carefully. I

HILSCHER SOFTWARE LICENSE AGREEMENT -~

|
L This document is a legally valid contract between you and Hilscher Geselschaft fir N
Systemautomation meH (“Hilscher™).

Please read through this License Agreement carefully before installing and using the
software. By instaling the software and using i, whether in whole or in part, you accept all
of the provigions of this Agreement.

If you decline to accept these terms and cenditions, please do not install the software.
Instead, return it to us or the retailer from which you purchased it for a refund of the
9 |purchase price. &

() I do not accept the terms in the license agreement

InstaliShield

[ < Back ][ Mext = ] [ Cancel

Figure 120: SYCON.net License Agreement

» Select | accept the terms in the license agreement, if you agree to it.
» Click Next.
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5. Enter user information.

_
1) SYCON-net for netX - InstallShield Wizard il s

Customer Infermation \
Please enter your information.

Lser Mame:

i IUser Mame

Organization:

IOrganizah’on

InstaliShield

[ < Back ][ Mext = J [ Cancel

Figure 121: SYCON.net Customer Information

» Enter the user name and the name of the organization.
» Click Next.

6. Select setup type.

F ™
4 SYCON.net for net¥. - InstallShield Wizard 5
Setup Type \
Choose the setup type that best suits your needs.
Flease select a setup type.

All program features will be installed. (Requires the most disk
space.)

Choose which program features you want installed and where they
will be installed. Recommended for advanced users.

Instalishield

[ < Back ][ Mext = ] [ Cancel

%

Figure 122: SYCON.net Setup Type

» Select Complete if you want to install the complete software.
» Click Next.
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7. Install SYCON.net.

%

-
ﬁ! SYCOM.net for netX - InstallShield Wizard

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to begin the installation.

exit the wizard.

InstaliShield

If you want to review or change any of your installation settings, dick Back. Click Cancel to

S

[

<Back |

Install | [ Cancel

Figure 123: Start SYCON.net Installation

> Click Install to start the installation.

2 The components are being installed. This may take several minutes.

-
4] SYCON.net for netX - InstallShield Wizard

Installing SYCON.net for netX

The program features you selected are being installed.

may take several minutes.

Status:
Copying new files
A —

Please wait while the InstallShield Wizard installs SYCOM.net for net¥, This

Instalishield

-~

< Back

Mext =

%

Figure 124: SYCON.net Installation Status
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8. Finish Installation.

F R
%) SYCON.net for netX - InstallShield Wizard s

InstallShield Wizard Completed

The Installshield Wizard has successfully installed SYCON.net
for netX, Click Finish to exit the wizard,

A

Figure 125: Finish SYCON.net Installation

» Click Finish to complete the installation.

» SYCON.net is installed and can be started in the Start menu of
Windows by choosing All Programs > SYCON.net System
Configurator > SYCON.net.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
DOC130405UMO02EN | Revision 2 | English | 2017-04 | Released | Public © Hilscher 2013 - 2017



SYCON.net 97/147

4.3.3 Installing SYCON.net under Windows 8

1. Start the SYCON.net installation program.
» Close all application programs.

» Double-click the Communication-Solutions.exe file in the root
directory of the un-zipped Communication SolutionsDVD.

 The Flash start screen Communication Solutions is displayed:

Communication Solutions

Installation Guide

Install SYCOM.net Configuration Software
Documentation

Drivers, Software and Tools

hilscher
COMPETENCE IN
COMMUNICATION

- o .
FOWERTRK Wiodous JB00ED gereo

CINE the sutcmation bus

Figure 126: Start Screen Communication Solutions — Install SYCON.net

» Click on Install SYCON.net Configuration Software.

Note: As an alternative, you can also start the SYCON.net installation
program (i. e. the SYCON.net for netX InstallShield Wizard) by double-
clicking the SYCONnet netX setup.exe file in the Software\SYCON.net
directory of the Communication Solutions DVD.

You can reduce the number of Windows security questions by right-
clicking on the SYCONNet netX setup.exe file and choosing Run as
administrator from the context menu.

2 The SYCON.net installation program is started.
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2. Choose language for the setup.

g Select the language faor thiz installation from the choices below.

| English (United States) v|

[ ok

Figure 127: SYCON.net Setup Language

» Select the language for the setup.
> Click OK.
 The SYCON.net for netX InstallShield Wizard opens:

Welcome to the InstallShield Wizard for
SYCON.net for netX

The InstallShield(R) Wizard will install 5YCON.net for netX,
wersion 1.360.130301.9398 on your computer. To continue,
click Mext.

WARMNING: This program is protected by copyright law and
international treaties.

[ Mext> | | Cancel

Figure 128: SYCON.net Installation Information

» Click Next.
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3. Read the notes about major changes in SYCON.net.

Important Information

Flease read the followinig information carefully.

Notes about major changes in SYCON.net V1.350.x.x

Please read these notes carefully, since they contain important information about
major changes in SYCON.net.

Overview

1. Concerns Communication Modules comX

1.1. Opening old SYCOMN.net Project Files

2. Concerns PC Cards cifX and Communication Modules comX

()1 have not read the information yet

InstaliShield

Figure 129: Notes about Major Changes in SYCON.net

» Read the notes about major changes in SYCON.net carefully.
» Select | read the information, after you have read them.
» Click Next.

4. Accept license agreement.

License Agreement

FPlease read the following license agreement carefully.

HILSCHER SOFTWARE LICENSE AGREEMENT

This document is a legally valid contract between you and Hilscher Gesellschaft fiir
Systemautomation mbH (“Hilscher).

Please read through this License Agreement carefully before instaling and using the
software. By instaling the software and using #t, whether in whole or in part, you accept all
of the provigions of this Agreement.

If you decline to accept these terms and conditions, please do not install the software.
Instead, return it to us or the retailer from which you purchased it for a refund of the
purchase price.

(7)1 do not accept the terms in the license agreement

InstaliShield

| < Back || Mext > | | Cancel

Figure 130: SYCON.net License Agreement

» Select | accept the terms in the license agreement, if you agree to it.
» Click Next.
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5. Enter user information.

Customer Information

Flease enter your information.

User Mame:

Organization:

InstaliShield

Figure 131: SYCON.net Customer Information

» Enter the user name and the name of the organization.
» Click Next.

6. Select setup type.

Setup Type
Choose the setup type that best suits your needs.

Flease select a setup type.

All program features will be installed. (Requires the most disk
space.)

Choose which program features you want installed and where they
will be installed. Recommended for advanced users.

InstaliShield

Figure 132: SYCON.net Setup Type

» Select Complete if you want to install the complete software.
» Click Next.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
DOC130405UMO02EN | Revision 2 | English | 2017-04 | Released | Public © Hilscher 2013 - 2017



SYCON.net 101/147

7. Install SYCON.net.

Ready to Install the Program

The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

InstaliShield

Figure 133: Start SYCON.net Installation

> Click Install to start the installation.

2 The components are being installed. This may take several minutes.

Installing SYCON.net for net)
The program features you selected are being installed.

Please wait while the InstallShield Wizard installs SYCOM.net for net¥. This
may take several minutes.

Status:
Copying new files

Instalishield

Figure 134: SYCON.net Installation Status
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8. Finish Installation.

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed SYCONM.net
for netX, Click Finish to exit the wizard,

Cancel

Figure 135: Finish SYCON.net Installation

» Click Finish, to complete the installation.
> SYCON.net has been installed.

_} Note: To start SYCON.net, use the Windows key to change from the
desktop mode to the start screen of Windows 8. In the start screen, click
on the SYCON.net tile. If the tile is not displayed, right-click on an empty
space, then click on the All Apps button appearing in the lower part of
the start screen. A list featuring all available programs (Apps) opens. In
this list, SYCON.net is shown below SYCON.net System Configurator
and can be started by double-click.
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4.3.4 Installing SYCON.net under Windows 10

1. Start the SYCON.net installation program.
» Close all application programs.

» Double-click the Communication-Solutions.exe file in the root
directory of the un-zipped Communication SolutionsDVD.

 The Flash start screen Communication Solutions is displayed:

Communication Solutions

Installation Guide

Install SYCOM.net Configuration Software
Documentation

Drivers, Software and Tools

hilscher
COMPETENCE IN
COMMUNICATION

- o .
FOWERTRK Wiodous JB00ED gereo

CINE the sutcmation bus

Figure 136: Start Screen Communication Solutions — Install SYCON.net

» Click on Install SYCON.net Configuration Software.

_) Note: As an alternative, you can also start the SYCON.net installation
program (i. e. the SYCON.net for netX InstallShield Wizard) by double-

clicking the SYCONnet netX setup.exe file in the Software\SYCON.net
directory of the Communication Solutions DVD.

2 The SYCON.net installation program is started.

2. Choose language for the setup.

F B
Choose Setup Language ﬂ

g Select the language faor thiz installation from the choices below.
]

[Engisch sa) -

[ 0K ][ Cancel ]

Figure 137: SYCON.net Setup Language
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» Select the language for the setup.
» Click OK.

2 The SYCON.net for netX InstallShield Wizard opens:

1 SYCOM.net for netX - InstallShield Wizard X

Welcome to the InstallShield Wizard for
SYCON.net for netX

The InstallShield(R) Wizard will install SYCON.net for net,
version .= "\« == on your computer, To continue,
dick Next,

WARNING: This program is protected by copyright law and
international treaties.

Figure 138: SYCON.net Installation Information

> Click Next.

3. Read the notes about major changes in SYCON.net.

'_'E.‘ SYCOM.net for netX - InstallShield Wizard

Important Information

Please read the followinig information carefully.

Notes about major changes in SYCON.net V1 &l

Please read these notes carefully, since they contain important information about
major changes in SYCOM.net.

Concerns gateway devices netTAP NT 151

Gateway devices netTAP NT 151 require SYCOM.net version 1.400 (or higher) for
configuration.

Installshield

< Cancl
Figure 139: Notes about Major Changes in SYCON.net

» Read the notes about major changes in SYCON.net carefully.
» Select | read the information, after you have read them.

» Click Next.
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4. Accept license agreement.

License Agreement

Please read the following license agreement carefully,

ﬁ SYCOM.net for netX - InstallShield Wizard >

HILSCHER SOFTWARE LICENSE AGREEMENT A

This document is a legally valid contract between you and Hilecher Gesellschaft fur
Systemautomation mbH (*Hilscher).

Please read through this License Agreement carefulty before installing and using the
software. By installing the software and using it, whether in whele or in part, you accept all
of the provisions of this Agreement.

If you decline to accept these terms and conditions, please do not install the software.
Inztead, return it to us or the retailer frem which you purchased it for a refund of the
purchase price. b

(®)1 accent the terms in the license agreement

(7)1 do not accept the terms in the license agreement

Installshield

<o =

Figure 140: SYCON.net License Agreement

» Select | accept the terms in the license agreement, if you agree to it.

» Click Next.

5. Enter user information.

Customer Information

Please enter your information.

User Name:
|

Organization:

InstallShield

ﬁ.‘ SYCOM.net for netX - InstallShield Wizard X

= ==

Figure 141: SYCON.net Customer Information

» Enter the user name and the name of the organization.

> Click Next.
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6. Install SYCON.net.

ﬁ SYCOM.net for netX - InstallShield Wizard

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back, Click Cancel to
exit the wizard.

Installshield

< Back : Install ] Cancel

Figure 142: Start SYCON.net Installation

» Click Install to start the installation.
2 The components are being installed. This may take several minutes.

ﬁ.‘ SYCOM.net for netX - InstallShield Wizard —

Installing SYCON.net for netX
The program features you selected are being installed.

Please wait while the InstallShield Wizard installs SYCOM.net for netX. This
may take several minutes,

Status:

InstallShield

Figure 143: SYCON.net Installation Status
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7. Finish Installation.

ﬁ SYCOM.net for netX - InstallShield Wizard >

InstaliShield Wizard Completed

The InstallShield Wizard has successfully installed SYCOM.net
for netX. Clidk Finish to exit the wizard.

< Back Cancel
Figure 144: Finish SYCON.net Installation

» Click Finish to complete the installation.

2 SYCON.net has been installed and can be started in the Start menu of
Windows by choosing All Apps > SYCON.net.
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4.4  Uninstalling SYCON.net
4.4.1 Uninstalling SYCON.net under Windows XP

SYCON.net uninstall procedure.

Note: Files and folders added by the user will not be deleted by the

» Close all application programs.
>
2 The Control Panel opens:

B Control Panel

File Edit

.\_) Back

In the Start menu of Windows, choose Control Panel.

EEX
View  Favorites Tools  Help ‘E.
-\_) l.ﬁ p Search H_ Folders v
Address [} Control Panel hd | Go
rs

Mame -~

Comments

£

ﬂ"' Control Panel

[ Switch to Cateqgory view

See Also

II!) Accessibility Options

SE Add Hardware

' Add or Remaove Pragrams
8 Administrative Tools

‘” Aukomatic Updates

!-! cif Setup

Adjust your computer settings ...
Installs and kroubleshoats har...
_ Install or remove programs an...
Configure administrative settin, ..
Set up Windows ko automatical, ..
Setup cify Boards and channels

P, cif % Test

<7 Dake and Time

&- Display

EdFiash Playver

| Folder Options

ﬁ Fonts

& Game Controllers
‘ﬁIndexerstellung

B nteliry ama Driver
QInternet Ciptions

@ Keyboard

) Mouse

@,Network Connections
LPhone and Modern Options
e

% "Windows Update
(7)) Help and Support

Test vour cify Boards and Cha...
Set the date, time, and time z...
Change the appearance of vo..,
Manage Flash Plaver Settings
Customize the display of files a...
add, change, and manage fon...
add, remove, and configure g...
Microsoft OFfice Find Fast (tm)...
Steuern Sie die Grafikhardwar ...
Configure your Internet displa...
Customize your keyboard setti,.,
Cuskomize wour mouse setking. ..
Connects to other computers, ...
Configure your telephone diali. ..

Figure 145: Control Panel

>

In the Control Panel, double-click Add or Remove Programs.
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2 The Add or Remove Programs window opens:

# Add or Remove Programs |-_||E|rz|
o )
\Eﬁ Currently installed programs: [ show updates Sork by
Change or = e bl
Remaove ) —
rograms i Size  6.68ME
i Size  10.20MB
% @ Size  27.75MB
Add Hew el Size  335.00ME
Programs
i . Size 2.16MB
. Entries from other programs
Ej C- Size  1.50MB
AddfRemove |5 Size  0.20MB
Windows
Components ,ﬁ Size  10.31MB
i Size  10.13MB
@ {3 Size 3.E0MB
Set Program )
Access and o Size  0.16MB
Defaulks

T2 SYCON.net for netx

rom your camputer, click Change or Remaove, Remave

sl Size  D.5SMB v

Figure 146: Add or Remove Programs

» Select SYCON.net for netX entry.
» Click Remove.
2 A confirmation request appears:

Add or Remove Programs

\“.’) Are vou sure you want ko remove SYCON.net for net from your computer?

Figure 147: Confirmation Dialog

» Click Yes.
 SYCON.net is being uninstalled from your host system or PC.
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4.4.2 Uninstalling SYCON.net under Windows 7

_} Note: Files and folders added by the user will not be deleted by the
SYCON.net uninstall procedure.

» Close all application programs.
» In the Start menu of Windows 7, select Control Panel.
? The Adjust your computer’s settings window opens:

=)

|Search Control Pane! o]

O@v@ » Control Panel » - |$¢|

Adjust your computer’s settings View by:

Category ~

User Accounts

g System and Security
ﬂ Review your computer's status ) Change account type
; Back up your computer - N

Find and fix problems Appearance and

Personalization
Change the theme

a,_ Network and Internet
ul View network status and tasks
- Change desktop background

Choose homegroup and sharing options
Adjust screen resolution

, / Hardware and Sound - i
ﬁ‘ View devices and printers q Clock, Language, and Region
B Add a device l_ Change keyboards or other input

/ methods
E—% Programs Change display language
)

L Uninstall a program
%S e Ease of Access

Get programs ’ .
Let Windows suggest settings

Optimize visual display

Figure 148: Adjust Your Computer’s Settings Window

» Inthe Programs group, click Uninstall a program.
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2 The Uninstall or change a program window opens:

IR » Contolpne » progams » progamsmesss < | 5]

Control Panel Home

Uninstall or change a program

View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.

'@J Turn Windows features on or

gt Organize *  Uninstall Change  Repair 3= - @
Install a program from the -

netwark MName Publisher Installed On
|- 10/11/2011
= 22/08/2011
= 23/09/2011
i 25/08/2011
< Entries from other programs 25/08/2011
03 23/09/2011
=] 23/09/2011
@ 23/09/2011
[ SYCON.net for net - Lo nbH 29/11/2011
= Linsnsta 23/00/2011
Change
Repair
4 | [l +
= Hilscher GmbH Product version: 1.350.111128.7016
DT Help link: http://www.hilscher.com

Figure 149: Uninstall or Change a Program Window

» Right-click on the SYCON.net for netX entry and choose Uninstall
from the context menu.

2 A confirmation request appears:

Programs and Features

I Are you sure you want to uninstall SYCON.net for netx?

[C] Inthefuture, do not show me this dialog box

Figure 150: Confirmation Dialog

» Click Yes.
 SYCON.net is being uninstalled from your host system or PC.
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4.4.3 Uninstalling SYCON.net under Windows 8

_) Note: Files and folders added by the user will not be deleted by the
SYCON.net uninstall procedure.

» Inthe Start screen of Windows 8, right-click on an empty space.
2 The All apps button appears in the lower part of the screen:

All apps

Figure 151: All Apps Button

» Click All apps.
2 A list featuring all available programs (Apps) appears:

Microsoft Office Narrator

Picture Manager

7-Zip File Manager Microsoft Office Remote Desktop On-Screen
PowerPoint 2003 Connection Keyboard

oy 7-Zip Help ar ic ce Snipping Tool Windows Speech
; ) Recognition

Sound Recorder

Digitale Signatur g Notepad++ Steps Recorder
fur VBA-Projekte

Command Prompt

Microsoft Clip Sticky MNotes
Organizer

Computer

[P

Ethernet Device Windows Fax and Control Panel

Setup — Scan

“a

W SYCON.net ' @ Windows Jounal Default Programs

Microsoft Office Windows Media
Anwendungswied... Player

File Explorer

@ Microsoft Office Calculator WordPad Help and Support

Document Imaging

. Microsoft Office Character Map KPS Viewer Run

Document...

Microsoft Office Math Input Panel
Excel 2003

Task Manager

a4 § OF 8

Windows Defender

Microsoft Office . MNotepad E! Magnifier
Outlook 2003 - «

® & ©® @ 6 @ =)

Unpin from Start  Pin to taskbar Uninstall Open new Runas Open file
window administrator location

Figure 152: List of Installed Apps in Windows 8

» Inthe Apps list, right-click the SYCON.net entry.
2 The context menu opens in the lower part of the screen.
> In the context menu, click Uninstall.
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2 Windows 8 changes into “desktop mode” and opens the Programs and

Features window:

4 & « Programs » Programs and Features

Control Panel Home

Uninstall or change a program

v & Search Programs and Features @

View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or

Turn Windows features on or Repair.
off

Install a program frem the Organize « Change  Repair

network
Mame

-

Entries from other programs

[ B SYCON.net for netx

x|

<

Hilscher GmbH Product version:  1.360.130301.9398

Figure 153: Uninstall or Change a Program Window

» Select SYCON.net for netX entry.

» Above the list, click Uninstall.
2 A security question appears:

i Are you sure you want to uninstall SYCOM.net for netX?

Help link:  http:/fwww.hilscher.com

[] Inthefuture, do not show me this dialog box

Figure 154: Acknowledge Uninstall

> Click Yes.
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> If the ODM Tray (which is a feature of the SYCON.net installation) is
still active, the following window opens:

The following applications should be closed before continuing the
installation:

QDMTray exe

Automatically close applications and attempt to restart them after
setup iz complete.

() Do not close applications. (A Reboot may be required )

Figure 155: Close ODMTray Dialog

» Choose Automatically close applications and attempt to restart
them after setup is complete option, then click OK.

» SYCON.net is being uninstalled from your host system or PC.
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4.4.4 Uninstalling SYCON.net under Windows 10

1. Open the Programs and Features dialog window.

» Right-click on the Windows Start symbol, then choose Programs and
Features entry:

Programs and Features
Power Options

Event Viewer

System

Device Manager
Metwork Connections
Disk Management
Computer Management
Command Prompt

Command Prompt (Admin}

Task Manager
Control Panel
File Explorer
Search

Run

Shut down or sign out

Desktop

Figure 156: Open program manager in Windows 10
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2 The Uninstall or change a program window opens:

[E Programs and Features — [m| x
4 [ » ControlPanel 5 Programs » Programs and Features v | O Search Programs and Features O
Control Panel Home .
Uninstall or change a program
View installed updates To uninstall 2 program, select it from the list and then click Uninstall, Change, or Repair.
E; Turn Windows features on or
off Organize = Uninstall Change  Repair == - e
Install a pregram from the ~
network Mame Publisher Installed On  Size Version
i i — il
B b i B « P [T — " ™
Y Ly .
|- [ et [REE e 1T ]
-;-,gp- el | e I e ]
e e T e s | T ) ———y ] W
i 5B o em " mm & -~ [t Heil H L 1"
@ e S | i [F 5] [ = iuipd 1
-;-5| el ol B o LR et |
[ SYCON.net for netX Hilscher GmbH 4/312017 337MB  1.400.170125.19044
=] P = bl | L] as' w [® ] =
i) = SEESEE LR == msmmm i Laa® =l L (R ] ] = a =
[ =g g e - — = - Bl
[0 meemeegms g e e e " g = - (%] -
= Hilscher GmbH Product version:  1.400.170125.19044 Support link:  http:/fwww.hilscher.c... Size: 337 MB
DT Help link:  http:/fwww .hilscher.c... Update information:  http://www.hilscher.c...

Figure 157: Uninstall or change a program window

» Select SYCON.net for netX entry.
» Click Uninstall button located above the list.
2 A confirmation request appears:

Programs and Features

I Are you sure you want to uninstall SYCON.net for netX?

[ In the future, do not show me this dialog box Yes

Figure 158: Confirmation Dialog

» Click Yes.
» SYCON.net is being uninstalled from your host system or PC.
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5 netX Configuration Tool
5.1 Overview

With the netX Configuration Tool, you can configure or diagnose your
communication module. You can also use it to download or update the
firmware of your module. Note, however, that the tool can be used only for
slave devices, for master devices you have to use SYCON.net.

If the host system of your communication module runs under a Windows
operating system, you can install the netX Configuration Tool on your host
system for the above mentioned purposes. You can also install the tool on
a separate configuration PC under Windows, and then connect your
communication module via PCI Carrier Board (comX), Evaluation Board
(netJACK), USB or serial interface to the configuration PC and the netX
Configuration Tool.

The netX Configuration Tool is delivered on the Communication Solutions
DVD. You can start the installation program for the tool (the netX
Configuration Tool Setup Wizard) in the menu of the start screen of the
DVD. Instructions for this are provided on the following pages. You can also
start the installation program by double-clicking the
netXConfigurationUtility Setup.exe file in the Tools\Slave
Configuration Tool directory of the Communication Solutions DVD.
The setup program contains all components needed for the installation
under Windows XP, Windows Vista, Windows 7, Windows 8 and
Windows 10.

Please note the following:

¢ If the netX Configuration Tool shall access the communication module
via host interface or PC bus, you need to install the cifX Device Driver on
your host system or configuration PC. See chapter cifX Device Driver on
page 10.

e If the netX Configuration Tool shall access the communication module
via USB, you need to install the USB Driver on your host system or
configuration PC. See chapter USB Driver on page 50.

e You need administrator rights for installing or uninstalling the netX
Configuration Tool on your operating system.

¢ If an older version of the netX Configuration Tool is already installed on
your system, uninstall it first before you install the new version.

e A description of the user interface of the netX Configuration Tool and
information on how to use this tool to configure or diagnose slave
devices is provided in the operating instruction manual
netX Configuration Tool for cifX, comX and netJACK — Configuration of
Real Time Ethernet and Fieldbus Devices, DOC1102050IxxEN, stored
on the Communication Solutions DVD.

The netX Configuration Tool is equipped with an online help, which can
be started by clicking the Help button or pressing the F1 key.
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5.2 Installing netX Configuration Tool
5.2.1 Installing netX Configuration Tool under Windows XP

1. Start the netX Configuration Tool installation program.
» Close all application programs.

> Double-click the Communication-Solutions.exe file in the root
directory of the un-zipped Communication SolutionsDVD.

2 The Flash start screen Communication Solutions is displayed:

Communication Solutions

Installation Guide
Install SYCOMN.net Configuration Software
Documentation
Dirivers, Software and Tools
Install cift{/ netJACK Device Driver
Install USB Diagnosis Driver
Install ISB SPM DCriver
Start netHOST for Remote access
Install Slave Configuration Software
Driver-Toolkit for Programmers

Auxiliary Tools

@ eANcozn (CLink Deviceitet EthercAT™ Etheri‘et/IP P
Lo e elalolr] i b : IS t; e
POWERLINK TiModibus Sercos g‘isﬁﬂ“{m

. COMMUNICATION

Figure 159: Start Screen Communication Solutions — Install netX Configuration Tool

> In the menu, choose Drivers, Software and Tools > Install Slave
Configuration Software.

Note: As an alternative, you can also start the installation program (i. e.
the netX Configuration Tool Setup Wizard) by double-clicking the
netXConfigurationUtility_Setup.exe file in the Tools\Slave
Configuration Tool directory of the Communication Solutions DVD.
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2 The netX Configuration Tool Setup Wizard is started:

i# netX Configuration Tool V1.X

Welcome to the netX Configuration Tool V1.x —
Setup Wizard ﬂe}:,:.-[‘j..:s.."

COMPETENCE M
O Pl LR AT IO

The installer will guide you through the steps required to install nef< Confiquration Tool%1.x an
YOUr cComputer.

WARNING: This computer program is protected by copyright law and international freaties.
Unautharized duplication or distribution of this program, or any portion of it. may resultin severe civil
or criminal penalties, and will be prosecuted to the maximum extent possible under the: lew.

Cancel

Figure 160: netX Configuration Tool Setup Wizard
» Click Next.

2. Choose Installation options.
» The Select Installation Folder window is displayed:

i@ netX Configuration Tool V1.X

Select Installation Folder —

%: chen

COMPETENCE M
0 Pt LI A TR

The installer will install net< Configuration Toalw1.x to the following falder.

Toinstall in this folder, click "Mext". To install to a different folder. enter it below ar click "Browse".

Folder:

CAFrogrammeiHilscher GmbHynet< Configuration Toal wl.x 4 l Browse... l

l Digk Cost.. l

Install nefx Configquration ToolW1.x  foryourself, or for amyone who uses this computer:

(& Ewveryane

O Justme

Cancel ] [ < Back ] | Mext >

Figure 161: netX Configuration Tool Setup Wizard — Installation Options
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» If you accept the suggested standard installation directory, click Next. If
you prefer a different directory, enter the path directly in the Folder field
or click Browse to open the Browse for Folder dialog, in which you
can select a different directory.

» If you want to check which drive provides the required space for the
installation, click Disk Cost...

» If you want to restrict access to the netX Configuration Tool to your
login, click Just me option.

> Click Next.

3. Start the installation.
» The Confirm Installation window is displayed:

i# netX Configuration Tool V1.x

Confirm Installation

The installer is ready to install net<) Configuration Toal%1.x  onwour computer.

Click "Mext" to start the installation.

[ Cancel l l < Back l | Mext >

Figure 162: netX Configuration Tool Setup Wizard — Confirm Installation

» Click Next to start the installation.
2 netX Configuration Tool is being installed.

i netX Configuration Tool V1.x

Installing netX Configuration Tool V1.x

netx Configuration Tool%1.x s being installed.

Flease wait..

Figure 163: netX Configuration Tool Setup Wizard — Installation in Progress
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4. Finish installation.
 The Installation Complete window appears:

i# netX Configuration Tool ¥1.x

Installation Complete

net< Configuration Toal%1.x has been successfully installed.

Click "Close" to exit.

Figure 164: netX Configuration Tool Setup Wizard — Installation Complete

> Click Close to finish the Installation.

2 netX Configuration Tool has been installed and can be started in the
Start menu of Windows via All Programs > Hilscher GmbH > netX
Configuration Tool.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
DOC130405UMO02EN | Revision 2 | English | 2017-04 | Released | Public © Hilscher 2013 - 2017



netX Configuration Tool 122/147

5.2.2 Installing netX Configuration Tool under Windows 7

1. Start the netX Configuration Tool installation program.
» Close all application programs.

» Double-click the Communication-Solutions.exe file in the root
directory of the un-zipped Communication SolutionsDVD.

 The Flash start screen Communication Solutions is displayed:

Communication Solutions

Installation Guide

Install SYCON.net Configuration Software

Documentation

Drivers, Software and Tools
Install cif/ netJACK Device Driver
Install USB Diagnosis Driver
Install USB SPM Driver
Start netHOST for Remote access
Install Slave Configuration Software
Driver-Toolkit for Programmers
Augiliary Tools

A eANooen (CLink Deviceitet EinercAT™ Etheritet/IP s
e 1GEEn" ® . E
POWERLINK  1iModbus Sercos hilsche

COMPETENCE IN
COMMUNICATICN

Figure 165: Start Screen Communication Solutions — Install netX Configuration Tool

> In the menu, choose Drivers, Software and Tools > Install Slave
Configuration Software.

Note: As an alternative, you can also start the installation program (i. e.
the netX Configuration Tool Setup Wizard) by double-clicking the
netXConfigurationUtility_Setup.exe file in the Tools\Slave
Configuration Tool directory of the Communication Solutions DVD.
You can reduce the number of Windows security questions by right-
clicking on the netXConfigurationUtility_Setup.exe file and choosing Run
as administrator from the context menu.
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2 The netX Configuration Tool Setup Wizard is started:

[ =
] netX Configuration Tool V1.x El_l-s‘v_hj

Welcome to the netX Configuration Tool V1 .x =
Setup Wizard ﬂ

EET
COMBETENCE I
CORMUNIC ATION

The installer will guide pou through the steps required to install net Configuration Tool V¥1.x on
your computer.

WARMIMG: Thiz computer pragram iz pratected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may result in sevene civil
or criminal penalties, and will be prozecuted to the maximum extent pozzible under the law.

Cancel < Back
LY

Figure 166: netX Configuration Tool Setup Wizard

> Click Next.

2. Choose Installation options.
2 The Select Installation Folder window is displayed:

#3 netX Configuration Toal V1.x El_lél

Select Installation Folder —

L E e
ABE TRNEE 1N
LSIEATICRN

co
Coma

The ingtaller will install nets Configuration Tool%1.% to the following folder.

Toinstall in this folder. click "Mext". Taoinstall to a different folder, enter it below or click "Browse".

Folder:

C:AProgram Files [#8E])4Hilzcher GmbHYnet< Configuration Tool W1.x Browse. ..
Dizk Cost...

Install netX Configuration Tool V1.%  for yourself, or for anyone who uses this computer:

@) Evemone

Just me

| Cancel | | < Back | | MNext » |

e

Figure 167: netX Configuration Tool Setup Wizard — Installation Options

» If you accept the suggested standard installation directory, click Next. If
you prefer a different directory, enter the path directly in the Folder field
or click Browse to open the Browse for Folder dialog, in which you
can select a different directory.
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» If you want to check which drive provides the required space for the
installation, click Disk Cost...

» If you want to restrict access to the netX Configuration Tool to your
login, click Just me option.

> Click Next.

3. Start the installation.
2 The Confirm Installation window is displayed:

F |
ﬁ net¥ Configuration Teol V1% Iil_léj

Confirm Installation

The inztaller is ready to install net= Configuration Tool%1.%  on your computer.

Click "Mext" to start the installation.

l Cancel ] [ < Back ] | Mest > |

e

Figure 168: netX Configuration Tool Setup Wizard — Confirm Installation

» Click Next to start the installation.
2 netX Configuration Tool is being installed.

rﬁ' netX Conﬁgurat]on-'l'ocl V1 l — £ )
Installing netX Configuration Tool —

V1 .x ﬂ el

net Configuration Tool %13 is being installed.

Please wait...

< Back Mest »

b

Figure 169: netX Configuration Tool Setup Wizard — Installation in Progress
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4. Finish installation.

 The Installation Complete window appears:

-
'ﬁ‘_—,] net¥ Configuration Tool V1.x

Installation Complete

Click "Cloza" to exit.

net Configuration Toal %1% has been successfully installed.

Cancel

< Back

Cloze:

b

Figure 170: netX Configuration Tool Setup Wizard — Installation Complete

> Click Close to finish the Installation.

2 netX Configuration Tool has been installed and can be started in the
Start menu of Windows via All Programs > Hilscher GmbH > netX

Configuration Tool.
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5.2.3 Installing netX Configuration Tool under Windows 8

1. Start the netX Configuration Tool installation program.
» Close all application programs.

» Double-click the Communication-Solutions.exe file in the root
directory of the un-zipped Communication SolutionsDVD.

 The Flash start screen Communication Solutions is displayed:

Communication Solutions

Installation Guide

Install SYCON.net Configuration Software

Documentation

Drivers, Software and Tools
Install cif/ netJACK Device Driver
Install USB Diagnosis Driver
Install USB SPM Driver
Start netHOST for Remote access
Install Slave Configuration Software
Driver-Toolkit for Programmers
Augiliary Tools

A eANooen (CLink Deviceitet EinercAT™ Etheritet/IP s
e 1GEEn" ® . E
POWERLINK  1iModbus Sercos hilsche

COMPETENCE IN
COMMUNICATICN

Figure 171: Start Screen Communication Solutions — Install netX Configuration Tool

> In the menu, choose Drivers, Software and Tools > Install Slave
Configuration Software.

Note: As an alternative, you can also start the installation program (i. e.
the netX Configuration Tool Setup Wizard) by double-clicking the
netXConfigurationUtility_Setup.exe file in the Tools\Slave
Configuration Tool directory of the Communication Solutions DVD.
You can reduce the number of Windows security questions by right-
clicking on the netXConfigurationUtility_Setup.exe file and choosing Run
as administrator from the context menu.
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> The netX Configuration Tool Setup Wizard is started:

Welcome to the netX Configuration Tool V1 .x g
Setup Wizard chen

The inztaller will guide pou thraugh the steps required to install net Configuration Tool W1.% on
pour computer.

WARMIMG: Thiz computer program iz pratected by copyright law and international treaties.
Unautharized duplication or distribution of this program, or ang portion of it, may result in severe civil
ar criminal penalties, and will be prazecuted to the maxinum extent pozzsible under the law.

Figure 172: netX Configuration Tool Setup Wizard

» Click Next.

2. Choose Installation options.
2 The Select Installation Folder window is displayed:

Select Installation Folder g

The installer will install net= Configuration Tool W12 ta the following folder.

Toinztall in this folder, click "Mext". Taoinstall to a different folder, enter it below or click "Browse".

Folder:

C:\Pragram Filas [#861\Hilzcher GmbH\netx Canfiguration Toal W1.06 Browse...

Install net® Corfiguration Toal %1.% for yourseff, or for anyone who uses this computer:

(®) Everyone
) Just me

| | < Back | | Mest »

Figure 173: netX Configuration Tool Setup Wizard — Installation Options

» If you accept the suggested standard installation directory, click Next. If
you prefer a different directory, enter the path directly in the Folder field
or click Browse to open the Browse for Folder dialog, in which you
can select a different directory.
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» If you want to check which drive provides the required space for the
installation, click Disk Cost...

» If you want to restrict access to the netX Configuration Tool to your
login, click Just me option.

> Click Next.

3. Start the installation.
2 The Confirm Installation window is displayed:

Confirm Installation ﬁw

The inztaller iz ready to ingtall netx Configuration Tool ¥1.5  on your computer.

Click "Mext" to start the installation.

Figure 174: netX Configuration Tool Setup Wizard — Confirm Installation

» Click Next, to start the installation.
2 netX Configuration Tool is being installed.

Installing netX Configuration Tool
Y1 .x 37

net Configuration Toal V1. iz being installed.

Please wait...

Figure 175: netX Configuration Tool Setup Wizard — Installation in Progress
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4. Finish installation.
 The Installation Complete window appears:

1) netX Configuration Tool V1.x = &

Installation Complete r
| SEhen

CORMBETENCE I
CORAMURICATION

net Configuration Toal %1« has been successfully installed.

Click "Close" to exit.

Caticel < Back

Figure 176: netX Configuration Tool Setup Wizard — Installation Complete

» Click Close, to finish the Installation.
2 netX Configuration Tool has been installed.

Note: To start the netX Configuration Tool, use the Windows key to
change from the desktop mode to the start screen of Windows 8. In the
start screen, click on the netX Configuration Tool tile. If the tile is not
displayed, right-click on an empty space, then click on the All Apps
button appearing in the lower part of the start screen. A list featuring all
available programs (Apps) opens. In this list, netX Configuration Tool is
shown below Hilscher GmbH and can be started by double-click.
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Installing netX Configuration Tool under Windows 10

1. Start the netX Configuration Tool installation program.
» Close all application programs.

» Double-click the Communication-Solutions.exe file in the root
directory of the un-zipped Communication SolutionsDVD.

 The Flash start screen Communication Solutions is displayed:

Communication Solutions

Installation Guide
Install SYCON.net Configuration Software
Documentation
Drivers, Software and Tools
Install cif/ netJACK Device Driver
Install USB Diagnosis Driver
Install USB SPM Driver
Start netHOST for Remote access
Install Slave Configuration Software
Driver-Toolkit for Programmers

Auxiliary Tools
A CANopen (((Link Deviceilet EthercAT™ Etheritet/IP '—;L
o & "TE .
(e elnolF]1 SENE
e Wocus sercos hilscher

COMMUNICATION

Figure 177: Start Screen Communication Solutions — Install netX Configuration Tool

130/147

> In the menu, choose Drivers, Software and Tools > Install Slave

Configuration Software.

Note: As an alternative, you can also start the installation program (i. e.
the netX Configuration Tool Setup Wizard) by double-clicking the

netXConfigurationUtility_Setup.exe file in the Tools\Slave

Configuration Tool directory of the Communication Solutions DVD.
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2 The netX Configuration Tool Setup Wizard is started:

4 netx Configuration Tool - X

Welcome to the netX Configuration Tool &1 1= s

Setup Wizard hilsclher

The installer will guide vou through the steps required to inzstall nef= Configuration Tool W an

your computer.

WARMIMG: This computer program is protected by copyright law and international breaties.

Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be prosecuted to the maximnum extent possible under the law.

Cancel < Back

Fi

>

gure 178: netX Configuration Tool Setup Wizard

Click Next.

2. Choose Installation options.
» The Select Installation Folder window is displayed:

## netx Configuration Tool - st

Select Installation Folder

The inzstaller will install nets Configuration Tool 17 to the following folder.

To install in this folder, click "Next". To install bo a different folder, enter it below or click "Browse".

Folder:
C:\Pragram Files [«86])\Hilzcher GmbHYnet< Configuration Tool W1.09 Browsze...

Dizk Cost...

Install net Configuration Tool B for yourself, or for anyone who uses this computer:

(®) Everyone
() Just me

Cancel < Back

Figure 179: netX Configuration Tool Setup Wizard — Installation Options

>

If you accept the suggested standard installation directory, click Next. If
you prefer a different directory, enter the path directly in the Folder field
or click Browse to open the Browse for Folder dialog, in which you

can select a different directory.
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» If you want to check which drive provides the required space for the
installation, click Disk Cost...

» If you want to restrict access to the netX Configuration Tool to your
login, click Just me option.

> Click Next.

3. Start the installation.
2 The Confirm Installation window is displayed:

4 netX Configuration Tool - *
Confirm Installation r
h SENEH
COMPETENCE i
OO MUBICATION
The installer iz ready ta install net Configuration Taool 7 ™98 on your computer.

Click "MNewxt" to ztart the installation.

Figure 180: netX Configuration Tool Setup Wizard — Confirm Installation

» Click Next to start the installation.
2 netX Configuration Tool is being installed.

j’_é_f' net¥ Configuration Tool - >
Installing netX Configuration Tool r
i i hllsclher
net= Configuration T ool 1 iz being installed.

Please wait...

Figure 181: netX Configuration Tool Setup Wizard — Installation in Progress
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4. Finish installation.

 The Installation Complete window appears:

j’_{f,‘ net¥ Cenfiguration Tool

Installation Complete

Click "Cloze" to exit.

netx Configuration Tool & M98 haz been successfully installed.

Cancel

< Back

ped

COMPETENEE N
CORA MURICATION

Cloze

Figure 182: netX Configuration Tool Setup Wizard — Installation Complete

> Click Close to finish the Installation.

2 netX Configuration Tool has been installed and can be started in the
Start menu of Windows via All Programs > netX Configuration Tool.
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5.3 Uninstalling netX Configuration Tool
5.3.1 Uninstalling netX Configuration Tool under Windows XP
» Close all application programs.
> In the Start menu of Windows, choose Control Panel.
2 The Control Panel opens:
B Control Panel |Z|:|i|
File Edit “iew Favorites Tools  Help
\_) Barck \_‘J l.ﬁ p Search I{ Folders -
Address [} Contral Panel V| G0
— MName -~ Comments )
R"' Control Panel -3 &Accessibility Cptions Adjust your computer settings ...
£ add Hardware Installs and troubleshoots har. ..

) Add or Remove Programs
48 Administrative Tools

% Automatic Updates
!-!cifx Setup

Do ciF % Test

:5’Date and Time
‘g\Display

Flash Plarver

| Folder Options

ﬁants

‘& Game Controllers
‘ﬁlndexerstellung

A trteiiry M Driver
QInternet Cptions
@mKeyboard

)y Mouse

*_;Network Connections
LF‘hone and Modern Opkions
e

B Switch to Cateqary Yiew

See Also

ﬁ Windows Update
(7)] Help and Support

h Install or remowe programs an...

Configure administrative setkin, .
Set up Windows ko autornatical...
Setup cif¥ Boards and channels
Tesk wour cif¥ Boards and Cha. ..
Set the date, time, and time z...
“hange the appearance of vo...
Manage Flash Player Settings
Customize the display of files a...
add, change, and manage fon...
Add, rermove, and configure ...
Microsoft Office Find Fask (tm)...
Steuern Sie die Grafikhardwar, .
Configure wour Internet displa. ..
Customize vour kevboard setti. ..
Customize your mouse setking...
Zonnects to other computers, ...
Zonfigure wour telephone diali,..

Figure 183: Control Panel

» Inthe Control Panel, double-click Add or Remove Programs.

2 The Add or Remove Programs window opens:

# Add or Remove Programs

%j Currently installed programs:

[ show updates

Change or e
Remove Cia
Pragrams 4

o
g‘? &
Add Mew
Programms ﬁ!
i) Entries from other programs
Add{Remove .

Windows =]
Companents

& netx Configuration Tool ¥1.x

@ -

Sek Prograrm
Access and

Defaults m

upparkt information,

To change this prograrn of re Fram your compuker

-~
Size  E.68ME

Size  10.20ME
Size  Z27.75ME

Size  335.00ME

Size 2. 16MB
Size 1.69MB
Size 0.20MB

Size  10.31ME

Size 0.55ME

Figure 184: Add or Remove Programs
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» Select netX Configuration Tool entry.
» Click Remove.
2 A confirmation request appears:

\_‘{/ Are you sure vou want to remove nety Configuration Tool % .x From your computer?

Figure 185: Confirmation Dialog

> Click Yes.

2 netX Configuration Tool is being uninstalled from your host system or
PC.
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5.3.2 Uninstalling netX Configuration Tool under Windows 7
» Close all application programs.
> In the Start menu of Windows 7, select Control Panel.
2 The Adjust your computer’s settings window opens:
[E=8 ECN ~x™)
O@v|@ v Contrel Panel » - | g | | |Search Controt Panet 2 |
Adjust your computer's settings View by: Category ¥
|@| System and Security % User Accounts
L I Review your computer's status - )
\‘3 Back up your computer @ Change account type
Find and fix problems _ Appearance and
Network and Internet @ Personalization
&I View network status and tasks Change the theme
“&2., Choose homegroup and sharing options Change desktop background
Adjust screen resclution
, / Hardware and Sound .
%‘ View devices and printers Clock, Language, and_Reglon
) Add a device = Change keyboards or ether input
F methods
|Tr--_ ngrams Change display language
h ';j glnm” =g @ W Ease of Access
e | ) Let Windows suggest settings
\J Optimize visual display
|
Figure 186: Adjust Your Computer’s Settings Window
» Inthe Programs group, click Uninstall a program.
2 The Uninstall or change a program window opens:
[ = | B ]
@Ov v Control Panel » Programs » Programs and Features - |¢, Search Programs and Features pel |
Control Panel FiESS Uninstall or change a program
View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.
B Tum Windows features on or
2l Organize *  Uninstall Change  Repair 4= = @
Install a program from the =
network Mame Publisher Installed On
|- 10/11/2011
= 22/08/2011
fel 23/09/2011
o 25/08/2011
<1 Entries f th 25/08/2011
03 ntries from other programs 23/09/2011
03 23/09/2011
@ 23/09/2011
[T netX Configuration Tool V1.x il cb or Con bl 20/11/2011
[ Uninstall 29/11/2011
= Change 23/09/2011
Repair
4| 1 +
1| Hilscher GmbH Product version: 1.05.03
|
. Help link: www.hilscher.com

Figure 187: Uninstall or Change a Program

Software Installation comX and netJACK | Installing Drivers and Configuration Software

DOC130405UMO2EN | Revision 2 | English | 2017-04 | Released | Public

© Hilscher 2013 - 2017



netX Configuration Tool 137/147

» Right-click on the netX Configuration Tool entry and choose Uninstall
from the context menu.

2 A confirmation request appears:

Programs and Features

! _ Areyou sure you want to uninstall net Configuration Tool W1.x 7
k

[7] Inthe future, do not show me this dialog box Yes I [ No

Figure 188: Confirmation Dialog

> Click Yes.

2 netX Configuration Tool is being uninstalled from your host system or
PC.
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5.3.3

Uninstalling netX Configuration Tool under Windows 8

» In the Start screen of Windows 8, right-click on an empty space.
2 The All apps button appears in the lower part of the screen:

All apps

Figure 189: All Apps Button

» Click All apps.

2 A list featuring all available programs (Apps) appears:

ApPpPS

Adobe Reader X Neues Office-

Dokument

w

Bing News 7-Zip File Manager

@ 0

Office-Dokument
offnen

Browser Choice 7-Zip Help

7 0

Calendar People

|
(&

§ netX Conﬁguratior?/
A Tool

Camera Photos

o)

Desktop Reader Open Log Folder

[

Finance SkyDrive

R

Games Sports Digitale Signatur

fur VBA-Projekte

Internet Explorer Store

Microsoft Office
2003 Assistent zu...

Travel

M ® 3

Microsoft Office
2003...

[WET Video

Weather Microsoft Office

Anwendungswied...

Messaging

Music

@

Pin to taskbar

Document Imaging

®

Unpin from Start

® @ 6 @

Uninstall Open file
location

Run as
administrator

Open new
window

1<)

N B

< |

Microsoft Office
Document...

Microsoft Office
Excel 2003

Microsoft Office
Qutlock 2003

Microsoft Office
Picture Manager

Microsoft Office
PowerPoint 2003

Microsoft Office
Word 2003

Notepad++

Calculator
Character Map
Math Input Panel

Notepad

Figure 190: List of Installed Apps in Windows 8 — Uninstall netX Configuration Tool

> Inthe Apps list, right-click the netX Configuration Tool entry.
2 The context menu opens in the lower part of the screen.
> In the context menu, click Uninstall.
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2 Windows 8 changes into “desktop mode” and opens the Programs and
Features window:

1 [&l « Programs » Programs and Features v & Search Programs and Features 0

Control Panel Home

Uninstall or change a program

View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or

Turn Windows features on or Repair.
off

Install a program from the Organize - Change  Repair

network -
Name

Entries from other programs

Cia
oa

|ﬂ netX Configuration Tool

&

£
I Hilscher GmbH Product version:  1.06.00
. Help link:  www.hilscher.com

Figure 191: Programs and Features Window

» Select netX Configuration Tool entry.
> Above the list, click Uninstall.
> A security question appears:

ﬁ Are you sure you want to uninstall netx Configuration Toel V1.2

[] Inthe future, do not show me this dialog box

Figure 192: Acknowledge Uninstall

» Click Yes.
» netX Configuration Tool is being uninstalled from your host system or
PC.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
DOC130405UMO02EN | Revision 2 | English | 2017-04 | Released | Public © Hilscher 2013 - 2017



netX Configuration Tool 140/147

5.34 Uninstalling netX Configuration Tool under Windows 10

1. Open the Programs and Features dialog window.

» Right-click on the Windows Start symbol, then choose Programs and
Features entry:

Programs and Features
Power Options

Event Viewer

System

Device Manager
Metwork Connections
Disk Management
Computer Management
Command Prompt

Command Prompt (Admin}

Task Manager
Control Panel
File Explorer
Search

Run

Shut down or sign out

Desktop

Figure 193: Open program manager in Windows 10
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2 The Uninstall or change a program window opens:

[E Programs and Features

Control Panel Home

View installed updates

) Turn Windows features on or
off

Install a program from the
network

1 [@ » Control Panel » Programs » Programs and Features

v 0

Uninstall or change a program

To uninstall a program, select it from the list and then click Uninstall, Change, or Repair,
Organize *  Uninstall Change Repair
MName - Publisher Installed On
p— —
[ [P . [T L
E-, 2 g P vl e i cnilw Fon™ Powes 0o e L= p
- [ = (R
-;if;p- -y "R BEIE ap L
A e el Wil i
& B o Cum "emn L - o
[ L ol i | S S
T g oy Ll | Ly
net= net){ Configuration Tool V7 /80 Hilscher GmbH 4/3/2017
(o] i RN N B i & B0 FE— - el
[ e sy 11§ el o5 e L ma L
(o] gy e 1-F g g -
(0] gy e e b g — g -

Hilscher GmbH Product version:  1.09.00
Help link:  www.hilscher.com

nek=

Size: 17.9MB

Size Version
g |

=1 B ol A

EilLE 1" =

M= &

17.9MB Eh

(& ] =
1 Bl = | =

Support link:  www.hilscher.com

— [m] >

Search Programs and Features 0
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Figure 194: Uninstall or change a program window

» Select netX Configuration Tool entry.
» Above the list, click Uninstall.
2 A security question appears:

Programs and Features

I Are you sure you want to uninstall net¥ Configuration Tool =

[ Inthe future, do not show me this dialog box Yes

Figure 195: Acknowledge Uninstall

> Click Yes.

» netX Configuration Tool is being uninstalled from your host system or

PC.
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6.3 Contacts

Headquarters

Germany

Hilscher Gesellschaft fiir
Systemautomation mbH
Rheinstrasse 15

65795 Hattersheim

Phone: +49 (0) 6190 9907-0
Fax: +49 (0) 6190 9907-50
E-Mail: info@hilscher.com

Support
Phone: +49 (0) 6190 9907-99
E-Mail: de.support@hilscher.com

Subsidiaries

China

Hilscher Systemautomation (Shanghai) Co. Ltd.

200010 Shanghai
Phone: +86 (0) 21-6355-5161
E-Mail: info@hilscher.cn

Support
Phone: +86 (0) 21-6355-5161
E-Mail: cn.support@hilscher.com

France

Hilscher France S.a.r.l.

69500 Bron

Phone: +33 (0) 4 72 37 98 40
E-Mail: info@hilscher.fr
Support

Phone: +33 (0) 4 72 37 98 40
E-Mail: fr.support@hilscher.com

India

Hilscher India Pvt. Ltd.
Pune, Delhi, Mumbai
Phone: +91 8888 750 777

E-Mail: info@hilscher.in

Italy

Hilscher ltalia S.r.l.

20090 Vimodrone (MI)

Phone: +39 02 25007068
E-Mail: info@hilscher.it
Support

Phone: +39 02 25007068
E-Mail: it.support@hilscher.com

Japan

Hilscher Japan KK

Tokyo, 160-0022

Phone: +81 (0) 3-5362-0521
E-Mail: info@hilscher.jp
Support

Phone: +81 (0) 3-5362-0521
E-Mail: jp.support@hilscher.com

Korea

Hilscher Korea Inc.

Seongnham, Gyeonggi, 463-400
Phone: +82 (0) 31-789-3715
E-Mail: info@hilscher.kr

Switzerland

Hilscher Swiss GmbH

4500 Solothurn

Phone: +41 (0) 32 623 6633
E-Mail: info@hilscher.ch

Support
Phone: +49 (0) 6190 9907-99
E-Mail: ch.support@hilscher.com

USA

Hilscher North America, Inc.
Lisle, IL 60532

Phone: +1 630-505-5301
E-Mail: info@bhilscher.us

Support
Phone: +1 630-505-5301
E-Mail: us.support@hilscher.com
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